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Safety Precautions and Instructions

A generator set and transfer switch, like
any other electromechanical device,
can pose potential dangers to life and
limb if improperly maintained or
operated. The best way to prevent
accidents is to be aware of potential
dangers and act safely. Please read
and follow the safety precautions and
instructions below to prevent harm to
yourself and others. This manual
contains several types of safety
precautions and instructions which are
explained below. SAVE THESE
INSTRUCTIONS.

A power monitor, like any other
electrical device, can pose potential
dangers to life and limb if improperly
installed, maintained, or operated.
Only trained and qualified personnel
should install, maintain, or operate the
power monitor or accessories. The
best way to prevent accidents is to be
aware of potential dangers and act
safely. Please read and follow the
safety precautions and instructions
below to prevent harm to yourself and
others. This manual contains several
types of safety precautions which are
explained below. SAVE THESE
INSTRUCTIONS.

A DANGER

Danger indicates the presence of a
hazard that will cause severe personal
injury, death, or substantial property
damage.

A WARNING

Warning indicates the presence of a
hazard that can cause severe personal
injury, death, or substantial property
damage.

A CAUTION

Caution indicates the presence of a
hazard that will or can cause minor
personal injury or property damage.

MP-5823 3/98

NOTICE
Notice communicates installation,
operation, or maintenance information
that is important but not hazard related.

Safety decals affixed to the power
monitor in prominent places advise the
operator or service technician of
potential hazards and how to act safely.
The decals are reproduced here to
improve operator recognition. Replace
missing or damaged decals.

Safety decals affixed to the generator
set in prominent places advise the
operator or service technician of
potential hazards and how to act safely.
The decals are reproduced in this
publication to improve operator
recognition. Replace missing or
damaged decals.

Safety decals affixed to the transfer
switch in prominent places advise the
operator or service technician of
potential hazards and how to act safely.
The decals are reproduced here to
improve operator recognition. Replace
missing or damaged decals.

Accidental Starting

A WARNING

I A%

Accidental starting.
Can cause severe injury or death.

Disconnect battery cables before
working on generator set. (Remove
negative (-) lead first when
disconnecting battery. Reconnect
negative (-) lead last when
reconnecting battery.)

Disabling generator set. Accidental
starting can cause severe injury or
death. Before working on the
generator set or connected equipment,
disable the generator set as follows:
1) Turn the generator set master switch
to OFF position. 2) Disconnect power
to battery charger. 3) Remove battery
cables (remove negative (-) lead first).
Reconnect negative (-) lead last when
reconnecting battery. Follow these
precautions to prevent starting of
generator set by an automatic transfer
switch or remote start/stop switch.

Safety Precautions and Instructions |



Hazardous Voltage/
Electrical Shock

A DANGER

“_

Hazardous voltage.
Will cause severe injury or death.

Disconnect all power sources before
opening enclosure.

(600 Volt and above)

A DANGER

‘_

Hazardous voltage.
Will cause severe injury or death.

Disconnect power sources before
servicing. Install barrier after
adjustments, maintenance, or
servicing.

(600 Volt and above)

A WARNING

‘_

Hazardous voltage.
Can cause severe injury or death.

Disconnect all power sources before
opening enclosure.

(under 600 Volt)

A WARNING

‘_

Hazardous voltage.
Can cause severe injury or death.

Disconnect power sources before
servicing. Install barrier after
adjustments, maintenance, or
service.

(under 600 Volt)

Il Safety Precautions and Instructions

Grounding generator set.
Hazardous voltage can cause
severe injury or death. Electrocution
is possible whenever electricity is
present. Open main circuit breakers of
all power sources before servicing
equipment. Configure the installation
to electrically ground the generator set
and electrical circuits when in use.
Never contact electrical leads or
appliances when standing in water or
on wet ground, as the chance of
electrocution increases under such
conditions.

Making line or auxiliary
connections. Hazardous voltage
can cause severe injury or death. To
prevent the possibility of electrical
shock, de-energize the normal power
source before making any line or
auxiliary connections.

Servicing transfer switch.
Hazardous voltage can cause
severe injury or death. De-energize
both normal and emergency power
sources before proceeding. Move
generator set master switch on
controller to OFF position and
disconnect battery negative (-) lead
before working on transfer switch! Turn
the transfer switch selector switch to
the OFF position.

Servicing transfer switch inner
panel. Hazardous voltage can cause
severe injury or death. Disconnect
inner panel harness at in-line
connector. This will de-energize circuit
board and logic circuitry but allow
transfer switch to continue to supply
utility power to necessary lighting and
equipment. Hazardous voltage exists
for any accessories mounted to inner
panel which are NOT wired through the
inner panel harness and de-energized
by in-line connector separation. Such
accessories are at line voltage.

Short  circuits. Hazardous
voltage/current can cause severe
injury or death. Short circuits can
cause bodily injury and/or equipment
damage. Do not contact electrical
connections with tools or jewelry while
making adjustments or repairs.
Remove wristwatch, rings, and jewelry
before servicing equipment.

Opening power monitor enclosure.
Hazardous voltage can cause
severe injury or death. Only trained
and qualified personnel should open
power monitor enclosure.

Opening power monitor enclosure.
Hazardous voltage can cause
severe injury or death. Transfer
switch or generator set, when part of
the system, can automatically energize
power monitor or accessories.
Disconnect all power sources before
opening enclosure. Move generator
set master switch on controller to OFF
position and disconnect battery
negative (-) lead before proceeding.

Current transformer voltage.
Hazardous voltage can cause
severe injury or death. Do not

disconnect current transformer leads
and reenergize the power source or
equipment damage and personal injury
may occur. If the situation requires
reenergizing the power source,
reconnect the current transformer
leads or short leads together first.

NOTICE

When replacing hardware, do not
substitute with inferior grade
hardware. Screws and nuts are
available in different hardness ratings.
American Standard hardware uses a
series of markings and metric hardware
uses a numeric system to indicate
hardness. Check markings on bolt
head and nuts for identification.

NOTICE
Electrostatic discharge damage!
Electrostatic discharge (ESD)
damages electronic circuit boards.
Prevent electrostatic discharge
damage by wearing an approved
grounding wrist strap when handling
electronic circuit boards or integrated
circuits. An approved grounding wrist
strap provides a high resistance (about
1 megohm), not a direct short, to
ground.
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Introduction

This manual covers the operation of the remote
monitoring and control communications software for
personal computers to communicate with Digital
Controller generator set controllers, MATS and MATS+
automatic transfer switch controllers, and Digital power
monitors.

All information found in this publication is based on data
available attime of print. The manufacturer reservesthe
right to make changes to this literature and the products
represented at any time without notice and without
incurring obligation.
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List of Related Materials

The software covered in this manual is part of a total
control system. Separate manuals are available for the
Digital Controller generator set controller, MATS and
MATS+ automatic transfer switch controller, and Digital
power monitor. They provide specific information to set
up the device to enable remote communications and
programming and additional information about device
functions.

The related manual numbers are as follows:

Operation/
Device Installation Manual
MATS Transfer Switch Controller MP-5604
MATS+ Transfer Switch Controller MP-5664
Digital Controller MP-5829
Digital Power Monitor MP-5875

Introduction i



Service Assistance

For sales and service in the U.S.A. and Canada check
the yellow pages of the telephone directory under the
heading GENERATORS—ELECTRIC for an authorized
Spectrum® service distributor/dealer.

For sales and service outside the U.S.A. and Canada,
contact your local distributor.

For further information or questions, contact the
company directly at:

i Introduction

Spectrum
N7650 County Trunk LS

Sheboygan, Wisconsin 53083 U.S.A.

Phone: 920-459-1877
Fax:  920-459-1825 (U.S.A. Sales)
920-459-1614 (International)
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Section 1. Requirements and Installation

1.1 Introduction

The Monitor software allows the operator to view the
status and make changes to settings and programming
on Digital Controller generator set controllers, MATS
and MATS+ transfer switch controllers, and Digital
power monitors using a personal computer (PC). The
software allows communication through local direct or
remote modem connections. See
Section 6—Communication Connections for further
information on the different configurations.

1.2 About this Manual

This manual is divided into seven sections:

e Section 1—Requirements and Installation
Explains the system requirements to run the
Monitor software and explains how to install it.

e Section 2—Main Menu explains the main menu of
the software and how to use it to locally or remotely
connect to a Digital Controller generator set
controller, MATS and MATS+ transfer switch
controller, and Digital power monitor.

e Section 3—Generator Set Controller Data
Menu explains the Digital Controller generator set
controller software operations. Areas covered
include viewing the current generator set
information, setting default alarms, changing
settings, and starting and stopping the generator
set.

e Section 4—ATS Controller Data Menu explains
the MATS and MATS+ transfer switch software
operations. Areas covered include viewing the
current automatic transfer switch information,
setting alarms, changing pick-up and drop-out
settings, setting the plant exerciser, and starting
and stopping a generator set.

e Section 5—Power Monitor Data Menu explains
the Digital power monitor software operations.
Areas covered include viewing the current
metering information, setting time delays,
changing settings, and running an ATS test.

e Section 6—Communication Connections
describes the hardware required to connect a PC
to Digital Controller generator set controllers,
MATS and MATS+ transfer switch controllers, and
the Digital power monitors locally, remotely, and
through a network.

® Section 7—Factory Setup Option Describes
how to enable and perform additional functions

with the Monitor software using the factory setup
option. These functions are normally performed
during installation of additional devices to the
system.

1.3 Hardware Requirements

The Monitor software requires the following minimum
hardware and software to operate:

® QOperating System: MS-DOS® version 4.0,
Windows® version 3.1, or Windows® 95.

® Microprocessor: 286

e Conventional Memory: 520K

® Extended memory: 4MB

® Disk Drive: One 3.5 inch high-density floppy drive.
e Hard Drive: 2MB available space

e Video adapter: VGA resolution, compatible with
the operating system

e Communication port: 2400, 4800, or 9600 baud
connected on COM1-4

1.4 Typographic Conventions

This manual uses the following typographical
conventions to distinguish different types of information.

Words in bold are command words. Type text in bold
exactly as shown.

Words in bold italic are system messages. System
messages display information from the system and
prompt you to make a choice or provide information to
the computer.

Words in <CAPS WITHIN BRACKETS> indicate key
names; a plus sign between two key names indicates
that the keys must be pressed in combination, i.e.,
<CTRL> + <F9>.

Words in Courier font indicate system information.

The convention —> shows a item or submenu in a menu
when using Windows®. For example, File->New
represents selecting New from the File menu.

For simplicity, this manual assumes that your PC has the
3.5 inch floppy drive installed as the A: drive and the
hard drive installed as the C: drive.

A pathname inside brackets represents system
pathnames. Type the pathname, not the brackets.
Example [c:\Monitor\Help\]. Brackets appear later in

Microsoft, MS, and MS-DOS are registered trademarks, and Windows is a trademark of Microsoft Corporation in the Unitied States and other countries.
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the manual to expand abbreviated messages displayed
on the screen. For example, Coolant Temp is the
abbreviation for Coolant Temperature that appears on
the screen; the text refers to this message as Coolant
Templ[erature].

1.5 Monitor Software

The Monitor software comes on a 3.5 inch floppy
diskette.  Although the software is an MS-DOS®
application, it can also run under Windows® 3.1 and
Windows® 95.

The Monitor software diskette contains an executable
file called Spectrum.exe which contains the Monitor
software. To run the Monitor software you need to
execute this file. The following procedures explain how
to use both MS-DOS® and Windows® to install the
software on the hard drive and to run the software from
your hard drive or the floppy drive.

The Monitor software diskette also contains a Help
directory. Installation and use of the help files is
optional.

Make a backup disk of all the files and directories from
the original Monitor software disk before using or
installing the software. Store the original disk in a safe
place. Use MS-DOS® or Windows® to perform the
backup.

Once the program runs it generates other files that the
program uses to store system information.

1.6 Installation of Monitor Software

NOTE
To run the Monitor software without installing it, refer to
Section 1.7 Running the Monitor Software from a Floppy
Drive.

Installation of the software on your hard drive involves
the following steps:

1. Creating a directory on the hard drive for the
software, optional help files, and
program-generated configuration files.

2. Copying the required files to the new directory from
a backup copy of the Monitor software disk.

3. Setting up the program for execution (Windows®
only).

Note that you can use MS-DOS® to perform all but the
last step to install the software, even if you run it under
Windows®.

1.6.1 MS-DOS

To install the Monitor software using MS-DOS® or to
copy the software to the hard drive using MS-DOS®
proceed as follows.

1. Create a Monitor directory on the hard drive.

a. Change directory to the hard drive by typing c:
and pressing <ENTER>.

b. Change the current directory to the root of the
C: drive by typing e¢d \ and pressing <ENTER>.
The typical MS-DOS® prompt appears C:\>.

c. Create a directory for the Monitor software by
typing md Monitor and pressing <ENTER>.

2. Copy the software to the Monitor directory.

a. Change directory to the Monitor directory by
typing ed Monitor and pressing <ENTER>.
The typical MS-DOS® prompt appears
C:\Monitor>.

b. Insert the backup copy of the Monitor software
disk into the 3.5 inch floppy disk drive A:

c. Type copy a:Spectrum.exe and press
<ENTER>.

3. Create a subdirectory in c:\Monitor for the help files
(optional).

a. Press <ENTER>. The typical MS-DOS®
prompt appears C:\Monitor>.

b. Create asubdirectory for the help files by typing
md Help and pressing <ENTER>.

4. Copy the help files to the hard drive (optional).

a. With the backup copy of the Monitor software
disk in the 3.5 inch floppy disk drive A:, type
cd Help and press <ENTER>. The typical
MS-DOS® prompt appears C:\Monitor\Help>.

b. Type copy a:\Help\*.* and press <ENTER> to
copy the help files to c:\monitor\help.

5. Set the Help File Path to [c:\Monitor\Help\] using
the Program Configuration screen to access the
help files on the hard drive from the program. See
Section 2.1 (optional).

6. Remove the backup copy of the Monitor software
disk from the A: drive.

Microsoft, MS, and MS-DOS are registered trademarks, and Windows is a trademark of Microsoft Corporation in the Unitied States and other countries.
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The Monitor software is now installed on the hard drive.
This completes installation of the software for operation
from MS-DOS®,

1.6.2 Windows 3.1
To install the Monitor software in Windows® Version 3.1.
1. Create a directory for the software.
a. Run File Manager.

b. Click onthe C: drive icon and then click on c:\in
the left pane.

¢. Use File->Create Directory from the toolbar to
create a new directory. In the Name: box type
Monitor and then click OK.

2. Copy the software.

a. Insert the backup copy of the Monitor software
into the 3.5 inch floppy drive A:.

b. Copy the contents of A: to C:\Monitor using File
Manager. If you copy the Help directory
(optional), change the help file path in the
Program Configuration screen to
[c:\Monitor\Help\].

3. Create a group item and program item that allows
starting the program from your desktop.

a. Switch to Program Manager and select
File->New.

b. Select Program Group from the Pop-up box
and click OK.

c. Type Spectrum Monitor in the Description box
and click OK.

d. Windows® creates a program group named
Spectrum Monitor on your Windows® desktop.

e. Select File->New from the Program Manager.

f. Select Program ltem from the Pop-up box and

click OK.

g. Type Spectrum Monitor in the Description:
box.

h. Type c:\Monitor\Spectrum.exe in the

Command Line: box.

i. Enter e¢:\Monitor in the Working Directory: box
and click OK.

1.6.3 Windows 95

To install the Monitor software in Windows® 95.

1. Create a directory for the software.

a. Run Windows® Explorer.
b. Click on your C: drive in the left pane.

¢. Choose File->New->Folder from the toolbar.
Explorer creates and highlights a new directory
labeled New Folder in the right pane. Type
Monitor and press <ENTER> to rename it.

2. Copy the software.

a. Insert the backup copy of the Monitor software
into the 3.5 inch floppy drive A:.

b. Copy the contents of A: to C:\Monitor using
Explorer. If you copy the Help directory
(optional), change the Help File Path in the
Program Configuration screen to
[c:\Monitor\Help\].

3. Create a shortcut that allows starting the program
from another location.

a. InExplorer click on C:\Monitor. Explorer shows
the contents of the directory in the right pane.
One of the files is Spectrum or Spectrum.exe.
Right click on Spectrum or Spectrum.exe in the
right pane and choose Create Shortcut.

b. Dragthe MS-DOS® shortcut icon file created to
the desktop or another directory.

You can also install the program in your
Start->Programs menu instead of making a shortcut.
To do so choose Start->Settings—>Taskbar, choose the
Start Menu Programs tab, and click Add. Follow the
instructions to create a shortcut for
C:\Monitor\Spectrum.exe to place in the desired part of
the Start->Programs menu.

1.7 Running the Monitor Software
From a Floppy Drive

This section explains how to run the software from a
floppy disk A: without installing it on the hard drive. Use
the backup copy of the software, not the original disk,
when running off the floppy drive.

If you wish to keep system information on the backup
Monitor floppy disk rather than re-entering the
information every time the program starts, ensure that
the write protect on the backup Monitor diskette is off
before proceeding and leave the disk in the A: drive
while the program runs so the computer can load and
save information.

Microsoft, MS, and MS-DOS are registered trademarks, and Windows is a trademark of Microsoft Corporation in the Unitied States and other countries.
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When the Monitor program starts for the first time, enter
the Monitor type. Type Y if your computer has a color
display or N if it has a monochrome display and press
<ENTER>. Choose the Program Configuration screen
from the Main Menu and provide the required
information before using the program.. See Section 2.5.

To access help screens go into the Program
Configuration screen and change the Help File Path to
[a:\Help\]. The program retrieves the help files from the
floppy disk.

When finished using the software, choose Quit from the
Main Menu and remove the Monitor software disk from
the drive before turning off the computer.

NOTE
If the Monitor software does not run, refer to
Troubleshooting later in this section.

1.7.1 MS-DOS
To start the Monitor software using MS-DOS® from the
floppy disk, follow the steps below:

1. Insertthe backup copy of the Monitor Software disk
into the 3.5 inch floppy disk drive A:.

2. Change directory to the A: drive by typing a: and
pressing <ENTER>. The typical MS-DOS® prompt
appears A:\>.

3. Type Spectrum.exe and press <ENTER>. The
Monitor program starts.

1.7.2 Windows 3.1

To start the Monitor software in Windows® 3.1 from the
floppy disk follow the steps below:

1. Insertthe backup copy of the Monitor Software disk
into the 3.5 inch floppy disk drive A:.

2. From the Program Manager select File—>Run.

3. Type a:\Spectrum.exe in the Command Line: box
and click OK. The Monitor program starts.

1.7.3 Windows 95

To start the Monitor software in Windows® 95 from the
floppy disk, follow the steps below:

1. Insertthe backup copy of the Monitor Software disk
into the 3.5 inch floppy disk drive A:.

2. Select Run from the Start menu.
3. Type a:\Spectrum.exe in the Open: box.
4. Selectthe OK button. The Monitor program starts.

1.8 Running the Installed Monitor
Software

Follow the procedures below for starting the Monitor
software installed on the hard drive using MS-DOS® or
Windows® .

When the Monitor program starts for the first time after
installation, enter the monitor type. Type Y if you have a
color display or N if you have a monochrome display and
press <ENTER>. Choose the Program Configuration
screen from the Main Menu and provide the required
information before using the program. See Section 2.5.

When finished using the software, choose Quit from the
Main Menu to end the program.

NOTE
If the Monitor software does not run, refer to
Troubleshooting later in this section.

1.8.1 MS-DOS

To start the installed Monitor software in MS-DOS®,
follow the steps below:

1. Set the current directory to the hard disk by typing
c¢: and pressing <ENTER>.

2. Setthe current directory to the Monitor directory by
typing cd \Monitor and pressing <ENTER>. The
typical MS-DOS® prompt appears C:\Monitor>.

3. Type Spectrum.exe and press <ENTER> The
Monitor program starts.

1.8.2 Windows 3.1

To start the installed Monitor software in Windows® 3.1,
double click on your Spectrum Monitor program group
and then double click on the Spectrum Monitor icon.

1.8.3 Windows 95

To start the installed Monitor software in Windows® 95,
double click on the shortcut you created during
installation or select it from your Start->Programs menu
if you placed it there.

Microsoft, MS, and MS-DOS are registered trademarks, and Windows is a trademark of Microsoft Corporation in the Unitied States and other countries.
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1.9 Uninstalling the Software

Use this section to uninstall the software on the hard
drive of your computer.

NOTE
Uninstalling the software permanently deletes all
information for your system entered into the Program
Configuration, Remote Single Connection, and Remote
Area Network screens!

1.9.1 MS-DOS

To remove the Monitor software running under
MS-DOS® delete the Monitor directory:

1. Change directory to the hard drive by typing ¢: and
pressing <ENTER>.

2. Change the current directory to the root of the C:
drive by typing ed \ and pressing <ENTER>. The
typical MS-DOS® prompt appears C:\>.

3. Delete the Monitor directory and its contents by
typing rmdir /s Monitor and pressing <ENTER> at
the MS-DOS® prompt. Confirm that you want to
delete the directory.

1.9.2 Windows 3.1

To remove the Monitor software running under
Windows® 3.1:

1. Delete the Monitor directory and its contents:
a. Run File Manager.

b. Click onthe C: drive icon and then click on c:\in
the left pane.

c. Click onthe Monitor directory in the right pane.

d. In File Manager select File->Delete from the
toolbar to delete the directory.

2. Delete the Windows® setup information:

a. Go to your desktop and select the Spectrum
Monitor program group.

b. Select File->Delete from the Program
Manager.
1.9.3 Windows 95

To remove the Monitor software from the computer
running under Windows® 95.

1. Delete the Monitor directory:
a. Run Windows® Explorer.

b. Click on your C: drive in the left pane.

c. Click on the Monitor directory in the right pane.

d. Choose File->Delete from the toolbar. Confirm
to delete.

2. Then delete the Windows® setup information:

a. If you created a shortcut to Spectrum or
Spectrum.exe on the desktop or other location
only during installation, delete the shortcut to
complete the removal of the software.

b. If you installed the software in your start menu,
choose Start->Settings—>Taskbar, choose the
Start Menu Programs tab and click on Remove.
Locate the shortcut to Spectrum.exe and click
on Remove to complete the removal of the
software.

1.10 Screen and Key Functions

The following function key notes appear at the bottom of
various screens within the program.

® The <ESC> key returns to the previous menu or
screen.

® The <F1> key displays the help screen for the
current menu or screen.

® The <F4> key updates the device settings by
transmitting the settings that the operator has
entered to the device for storage.

® The <F9> key displays a print menu:

® Print to Printer prints a hard-copy report of the
current screen to the printer the system
designates as LPT1.

® Save Report to a File asks to provide a name
for a file and saves the current screen report to
the file.

® Review Report provides a print preview of a
screen report.

® The <F10> key restores the Main Menu.

1.11 Monitoring and Programming
Setup

This section describes how to set up the remote control
and programming modes for monitoring and
programming using online PC connections and
describes the various online PC connections. See
Section 6 for details on communications hardware and
connections.

An online PC connection is Local meaning a direct cable
connection or itis Remote meaning a connection using a
telephone line and modem. PC connections can

Microsoft, MS, and MS-DOS are registered trademarks, and Windows is a trademark of Microsoft Corporation in the Unitied States and other countries.
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connect to a single device or a local area network (LAN)
of devices (a generator set controllers, automatic
transfer switch controllers, or power monitors), resulting
in four PC connection types: Local, Local Area Network,
Remote, and Remote Area Network. See Section 1.12
for more details about these connections.

Each of these four PC connection types work with
programming on or off for a total of eight combinations of
settings for online PC connections. See the table in
Figure 1-1 for the settings for each combination. While
programming the Remote Control settings for each
device, enter the following additional settings:

e Baud rate Enter the same baud rate for all
devices. Enter this same baud rate and the COM
port 1-4 used for PC communications on the
Program Configuration screen for the Monitor
software. See Section 2.5.

® Network Address Enter a unique network
address 1-128 for each device on each Local Area
Network or Remote Area Network site. Typically
assign addresses from 1 to the number of devices
on the network. If a network is not used, leave the
network address set to the default value of 1.

e System ID Enter the same System ID number into
all devices for each Remote Single or Remote Area
Network site. Enter this System ID number into the
Remote Unit Overview or Remote Network
Overview screen for the Monitor software along
with the site description, number of units, and
phone number at the site. See Section 2.2 and
Section 2.3 The System ID number works like a
password that only allows Monitor software with
the correct System ID number to access the site
using a modem.

Enable the Local programming mode first, program the
settings for Remote Control, and then change the
Programming Mode. See Figure 1-2 for the locations to
change these settings for different devices.

Note that you can always perform monitoring at the local
display regardless of these online PC connection
settings. Also, if you use an online PC connection to
perform monitoring, you can also turn the local
programming mode on and perform programming
locally simultaneously. See the note at the bottom of the
table in Figure 1-1.

Menu 8—Remote Control Menu 9—Programming Mode
Local Remote Local Remote
User Connection Area Area Programming | Programming  Programming
Activity Type On Line? | Local? Net? Remote? Net? Mode? Mode? Mode Off?

Local Yes No No No
Local Area
Network No Yes No No

Monitor only | Remote No No Yes No X No X*
Remote
Area No No No Yes
Network
Local Yes Yes No No No
Local Area No Ves No No

M g Network

onitor an

Program Remote No No Yes No No Yes No
Remote
Area No No No Yes
Network

X, X* While monitoring the system using an online connection, choose to enable the Local Programming Mode to perform programming

locally or the Programming Mode Off to disable all programming. To perform programming locally choose Yes for the setting
represented by X. To disable all programming choose Yes for the setting represented by X*.

Figure 1-1. Settings Required for Monitoring or Programming Using an Online PC Connection

6 Requirements and Installation
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Settings Change Location

Programming

Device Remote Control Mode
Generator Set Controller Menu 10 Menu 11
ATS Controller Index 13 Programming

Mode Switch
Power Monitor Menu 8 Menu 9

Figure 1-2. Locations for Changing Remote
Control and Programming Mode Settings

1.12 Online PC Connections

A PC can communicate with one or more generator set
controllers, automatic transfer switch controllers, and
power monitors. These PC connections require the
following optional items.

® Remote monitoring and control communications
software for the PC.

e A communications module in each device
(generator set controller, automatic transfer switch
controller, or power monitor).

® Other hardware depending upon the connection
type between the devices and the PC.

Contact your authorized distributor/dealer for

availability.

Use only Spectrum communications products specified
for use with Spectrum products. The manufacturer of
Spectrum assumes no responsibility for the use of
non-Spectrum communications products.

1.12.1 Local Single Connection

A PC connects directly to an RS-232 port of the
communication module installed in a device, such as a
generator set controller, with an RS-232 cable when the
PC is within 50 ft. (15 m) of the device. See Figure 1-3.
For longer connections, the PC connects to an RS-232
to RS-485 port converter within 50 ft. (15 m) of the PC.
Then an RS-485 cable can extend up to 4000 ft.
(1220 m) from the converter to a device with an installed
RS-485 communications module. See Figure 1-4.

MP-5823 3/98

1.12.2 Local Area Network (LAN)

A PC connects locally to an RS-485 local area network
(LAN) of up to 128 devices with an RS-232 to RS-485
converter. Acceptable devices for the LAN include the
Digital Controller, MATS and MATS+ automatic transfer
switch controllers, and Digital Power Monitor. See
Figure 1-5.

1.12.3 Remote Single Connection

A PC connects to a modem and a single device
connects to another modem. The PC communicates to
the device using the modems and the telephone
network. Locate the PC anywhere a telephone line is
available. See Figure 1-6.

1.12.4 Remote Area Network

A PC connects to amodem. Up to 128 devices connect
to an RS-485 local area network (LAN) interfaced to
another modem using an RS-232 to RS-485 port
converter., The PC communicates with the devices
using the modems and the telephone network. Locate
the PC anywhere a telephone line is available.
Acceptable devices for the LAN include the Digital
Controller, MATS and MATS+ automatic transfer switch
controllers, and Digital Power Monitor. See Figure 1-7.

Requirements and Installation 7



Generator Set
Controller,
Transfer Switch
Controller, or
Generator Set Power Monitor
[—] Controller, RS-232 to RS-485
Transfer Switch port converter Generator Set
Ooooooo_ T Controller, or Controller
... RS.232 Power Monitor 7,: | RS-232 "1 Transfer Switch
ersona Controller, or
Personal up to up to :
Computer 50 ft. (15 m) Computer 54 (15 m) Power Monitor
. . . Generator Set
Figure 1-3. Local Single Connection, L Controller
up to 50 ft. (15 m) RS-485 Connects Devices — Transfer Switch
up to 4000 ft. (1220 m) of Controller, or
Total Length Power Monitor
Generator Set
— Controller,
Generator Set Transfer Switch
= — RS-232 to RS-485 Controller, Controller, or
J port converter Transfer Switch Power Monitor
f Controller, or
Power Monitor H -
T RS.485 Figure 1-5. Local Area Network
Personal up to up to 4000 ft.
Computer 50 ft. (15 m) (1220 m)

Figure 1-4. Local Single Connection,
up to 4000 ft. (1220 m)

~
<\
>

—
-
|~

Generator Set

Transfer Switch

Do0o00a0 Controller, or
RS-232 RS-232 Power Monitor
up to Telephone up to
Personal 50 ft. (15 m) Lines 50 ft. (15 m)
Computer

Figure 1-6. Remote Single Connection

N
PN
RS-485 Connects Devices Generator Set Generator Set
up to 4000 ft. (1220 m) of Controller, Controller,
Total Length Transfer Switch | | Transfer Switch
| Controller, or Controller, or
Power Monitor Power Monitor
RS-232 to RS-485
port converter
Generator Set Generator Set
RS-232 L _ Controller, | | Controller,
Telephone up to __| Transfer Switch __| Transfer Switch
Personal RS-232 Lines 50 ft p(15 m) Controller, or Controller, or
Computer 50 flth(i(; m) . Power Monitor Power Monitor

Figure 1-7. Remote Area Network
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1.13 Troubleshooting

The computer on which the Monitor software is installed
may not run the program because of a memory error.
The error looks similar to one of these:

® Insufficient
application

memory to run

® Not enough memory

If these errors occur, create a boot disk to use each time
you run the Monitor software. Follow the steps below to
create a boot floppy disk:

1. Insert a blank disk into the floppy disk drive.

2. Type format drive letter:/S.
Example format a:/s
or format b:/s

3. Press <ENTER>.

4. Below are examples of AUTOEXEC.BAT and
CONFIG.SYS files that allow the Monitor program
to run if they are present on the boot floppy disk.
Use a text editor to create these files on the boot
floppy disk.

MP-5823 3/98

AUTOEXEC.BAT
@ECHO OFF

PATH C:\DOS

SET PATH=%PATH%;
PROMPT S$PS$SG
VERIFY OFF

CD MONITOR
SPECTRUM.EXE

CONFIG.SYS
SHELL=C:\COMMAND.COM C:\ /E:1024 /P
BREAK=OFF

DOS=HIGH, UMB

FILES=60

STACKS=9,256

BUFFERS=40
DEVICEHIGH=C:\DOS\ANSI.SYS

5. Use the boot floppy disk to reboot the system each
time you run the Monitor software.

6. Remove the disk and label the disk BOOT DISK:
MONITOR.
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Section 2. Main Menu

After starting the Monitor program, the Main Menu
appears. See Figure 2-1.

Spectrum Monitor Main Menu Version X.XX

Use 1 and | to choose an option. Press ENTER to select. Press F1 for Help.

Main Menu 1

Local Single Connection

Local Area Network

Remote Single Connection
Remote Area Network
Program Configuration

Quit 1

Figure 2-1. Main Menu Screen

The Main Menu allows you to select from the following
list of menu options listed in the order shown. Use the
up/down arrows to select a menu option. Press
<ENTER> to make the selection.

A device or unit means a generator set controller,
transfer switch controller, or power monitor compatible
with the Monitor software. The options are explained in
detail in the following sections.

NOTE

When the software runs for the first time it displays the
question, “Are you using a color monitor?” Type Y for
yes if the computer has a color display or N for no if the
computer has a monochrome display and press
<ENTER>. Also, if running the software for the first
time, select the Program Configuration option in the
Main Menu first and follow the instructions in Section 2.5
for completing the necessary information before
accessing other selections.

MP-5823 3/98

Main Menu Screen Options

Local Single Connection. Use ifthe device connects directly
tothe PC. Ifthe PC cannot establish communications with the
device within time periods specified in the Program
Configuration screen a communications error results. Press
<F10> to clear a communications error and return to the Main
Menu. When the software successfully communicates with
the device the Data Menu for the device type displays. See
Section 3 for a generator set controller Data Menu, Section 4
for a transfer switch controller Data Menu, or Section 5 for the
power monitor Data Menu.

Local Area Network. Use if the PC connects directly to an
RS-485 communication network of devices. If you select this
optionthe software requests the last address of devices onthe
network. Type the highest address number used on the
network and press <ENTER>. The software then displays the
Network Overview screen. See Section 2.1 and Figure 2-2. In
this screen you can select the desired device by its network
address.

Remote Single Connection. Allows you to use a PC and
modem to dial a single device site. This selection displays the
Remote Unit Overview screen to edit and enter information into
the site database or to dial a single device site. See Figure 2-3.

Remote Area Network. Allows youto use aPCand modemto
dialaremote RS-485 network of devices. This choice displays
the Remote Network Overview screen to edit and enter
information into the remote area network database or to dial
into a network site. See Figure 2-4. If you dial into a network
site and the software connects successfully to the site, the
software displays the Network Overview screen. See
Figure 2-2. Inthis screen you canselectthe desired device by
its network address.

Program Configuration. Allows you to configure the
software. If running the software for the first time, enter or
change the information here first. See Figure 2-5.

Quit. Ends the program.

Main Menu 11



2.1 Network Overview Screen

If you selected the Local Area Network option from the
Main Menu or the Dial option in the Remote Network
Overview screen and the software called the remote site
and made a successful connection with the selected
network, the software displays the Network Overview
screen. This screen displays a set of records that
identify and provide status information about the
individual devices the operator can monitor and control
using the software. See Figure 2-2.

Spectrum Monitor Network Overview Version X.XX

1 and | to choose. ENTER to select ESC Previous Menu. F1Help  F10 Main Menu.

Address | Designation Load Status | Type ﬁ
1 Office Area | Lighting R |DIGCON
2 Bay 21 Motors R |MATS+
3 SE 101 Main Office E [PWRMON

!

Status: Normal Pos, Emergency Pos, Off Pos, Device NOT Found, F-System Alert
Stopped, Running, Cranking

Figure 2-2. Network Overview Screen

Network Overview Screen Key Functions

Network Overview Record Fields

Address. Each device must have a unique address, a
number from 1-128, for the network to function properly. Enter
the address at the device’s local display and keypad under
Remote Control (Menu 10 on a Digital Controller generator set
controller, Index 13 on a MATS or MATS+ transfer switch
controller, or Menu 8 on a Digital power monitor).

Designation & Load. Displays the entries made on the
Information Setup screen. Go to the device’s Data Menu and
select the Information Setup Screen to modify these settings.

Status. The following status codes reflect the status of the
device or connected system:

The transfer switch is in the normal position
The transfer switch is in the emergency position
The transfer switch is in the off position

No device found

A system alert exists for the device

The generator set is stopped

The generator set is running

The generator set is cranking

OIJT»mwmMmoOoOoOmz=2

Type. A code for the type of device: DIGCON (Generator Set
Controller), MATS or MATS+ (Automatic Transfer Switch
Controller), or PWRMON (Power Monitor).

Key Screen Function
1.1
PgUp, Moves the cursor up or down to choose a
PgDn, to choose devi
evice

Home,
End

Displays the Data Menu for the chosen
ENTER to select device
ESC '\Pﬂrewous Returns to the previous menu or screen

enu
F1 Help Displays the help screen
Main .
F10 Menu Returns to the Main Menu
12 Main Menu

Move the cursor up or down to choose the device to
connect to. Press <ENTER> to go to the Data Menu to
communicate with that device.
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2.2 Remote Single Connection

If you selected the Remote Single Connection option on
the Main Menu, the software responds with the Remote
Unit Overview screen. This screen displays a list of
individual device sites the operator can monitor and
control using the software. See Figure 2-3.

Spectrum Monitor Remote Unit Overview Version X. XX
Dial Find Add Modify Insert Delete ESC
Site | Sys ID | Phone Number| # Units Site Description 1
1 1840 555 1111 1 | Main Office A
2 2090 | 333555 1234 1 | Medical Center
[
< and — for options. |, 1, PgUp, and PgDn for records. F1 Help. F10 Main Menu.
Figure 2-3. Remote Unit Overview
Remote Unit Overview Screen Key Functions
Key Screen Function
1.1
gggp, for Moves the cursor up or down to choose a
gn, records Remote Unit Overview device site record
Home,
End
for Move to select a menu option or to edit
<«— Of — .
options records
ENTER Performs the menu option selected
ESC to cancel Returns to the previous menu or screen
F1 Help Displays the help screen
Main .
F10 Menu Returns to the Main Menu

MP-5823 3/98

Remote Unit Overview Record Fields

Site. The number ofthe device site. The software canlistupto
128 separate sites.

Sys ID. The System ID number is a password for remote
access. Enter this number at the device's local display and
keypad under Remote Control (Menu 10 on a Digital Controller
generator set controller, Index 13 on a MATS or MATS+
transfer switch controller, or Menu 8 on a Digital power
monitor). The Sys ID of each device and the one entered on
the screen must match.

Phone Number. The telephone number for the device site. If
the telephone line service includes call waiting, prefix the
phone number with *70 fortone dialing or 7770 for pulse dialing
when entering telephone numbers into records. The prefix
disables call waiting for the duration of the call. If call waiting is
not disabled, an incoming call disconnects the modem from
the device. Consultthe localtelephone company to verify that
the above dialing prefixes are correct.

# Units. This field will always be 1 for a Remote Single
Connection (Remote Unit Overview screen).

Site Description. A description ofthe device’s location, loads,
etc.

Use the arrow keys to move the cursor up or down to
highlight a specific record. Use the left and right arrow
keys to highlight a menu option and press <ENTER> to
perform the highlighted operation:

® Dial. Callthe device site using the phone number in
the highlighted record. The software displays the
Data Menu for the device if it establishes a
connection.

® Find. Entera Sys ID numberto sendthe cursorto the
device site record with that Sys ID.

® Add. Sends the cursor to the end of the record list
where information about a new device site can be
added. Type the information into eachfield and press
<ENTER> to move to the next field.

® Modify. Edits the highlighted record. Type the
changestothe record’s fields and press <ENTER> to
move to the next field.

® Insert. Inserts a new record before the highlighted
record. Type the information into eachfield and press
<ENTER> to move to the next field. The difference
between Insert and Add is that Add always puts the
record at the end of the list.

® Delete. Deletes the highlighted record. The software
requests confirmation that you want to delete the
record.

® Esc returns to the Main Menu.
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2.3 Remote Area Network

If you selected the Remote Area Network option on the
Main Menu, the software responds with the Remote
Network Overview screen which displays a list of
network sites which may be monitored using the
software. See Figure 2-4.

Spectrum Monitor Remote Network Overview Version X. XX

Dial Find Add Modify Insert Delete ESC

Site Description

Site | Sys ID | Phone Number| # Units|
I I I

. —

1
1 1840 555 1111 5  Main Office
2 2090 | 333555 1234 4 | Medical Center

!

< and — for options. |, 1, PgUp, and PgDn for records. F1 Help. F10 Main Menu.

Figure 2-4. Remote Network Overview

Remote Network Overview Screen Key Functions

Key Screen Function
1.1
PgUp, for Moves the cursor up or down to choose a
PgDn, records Remote Network Overview network site
Home, record
End

for Move to select a menu option or to edit
<«— Of — .

options records
ENTER Performs the menu option selected
ESC to cancel Returns to the previous menu or screen
F1 Help Displays the help screen

Main .
F10 Menu Returns to the Main Menu

14 Main Menu

Remote Network Overview Record Fields

Site. The number ofthe network site. The software can listup
to 128 separate sites.

Sys ID. The System ID number is a password for remote
access. Enter this number at the device's local display and
keypad under Remote Control (Menu 10 on a Digital Controller
generator set controller, Index 13 on a MATS or MATS+
transfer switch controller, or Menu 8 on a Digital power
monitor). The Sys ID of each device and the one entered on
this screen must match.

Phone Number. The telephone numberforthe network site. If
the telephone line service includes call waiting, prefix the
phone number with *70 for tone dialing, or 7770 for pulse
dialing when entering telephone numbers into records. The
prefix disables call waiting for the duration of the call. If call
waiting is not disabled, an incoming call disconnects the
modem from the network. Consult the local telephone
company to verify that the above dialing prefixes are correct.

# Units. The number of devices at the network site.

Site Description. A description of the network’s location,
loads, etc.

Use the arrow keys to move the cursor up and down to
highlight a specific record. Use the left and right arrow
keys to highlight a menu option and press <ENTER> to
perform the highlighted operation:

® Dial. Calls the network site using the phone number
in the highlighted record. A successful call results in
the software displaying a Network Overview screen
for the network. See Section 2.4 for details.

® Find. Entera Sys ID numberto sendthe cursorto the
device site record with that Sys ID.

® Add. Sends the cursor to the end of the record list
where information about a new network site can be
added. Type new information into each field and
press <ENTER> to move to the next field.

® Modify. Edits the highlighted record. Type the
changestothe record’s fields and press <ENTER> to
move to the next field.

® Insert. Inserts a new record before the highlighted
record. Type the information into eachfield and press
<ENTER> to move to the next field. The difference
between Insert and Add is that Add always puts the
record at the end of the list.

® Delete. Deletes the highlighted record. The software
requests confirmation that you want to delete the
record.

® Esc returns to the Main Menu
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2.5 Program Configuration

Use the Program Configuration screen to configure the
Monitor software. If setting up the software for remote
communications for the first time, enter information in
this menu before proceeding. See Figure 2-5.

Spectrum Monitor Program Configuration Version X.XX

Fill in the program configuration record. Press ESC to cancel. F1 for Help.

Company Name & Address:

- Communication Configuration Setup
Port Number 1 (1-4) Touch Tone/Pulse Dialing T (T/P)
Baud Rate 2400 (2400, 4800, 9600) Communication Fault Retries 15
Modem Time Out 99 (seconds)

No Parity, 8 data bits, 1 stop bit

Personal Computer Configuration

Color Monitor? Y (Y/N)
Help File Path [A:\HELP\ ]

Figure 2-5. Program Configuration Screen

Entering Configuration Changes. You canchangeall
settings or only change specific items.

e All. Software automatically starts with Company
Name and Address. Fill in the information required
and press the <ENTER> key to enter the changes
and move to the next item. Repeat the process for
allremaining fields. If you have made changes and
pressed <ENTER> after the last item, the software
displays the options under After Making Changes
(below).

e Specific ltems. Use the up and down arrow keys
to select a specific item to change, make your
changes, and press <ENTER> to enter the
change.

After Making Changes. Press <ESC>. If you have
changed the program configuration settings, the screen
displays three menu options:

® Save to store configuration settings and return to
the Main Menu

® Cancel to return to the Main Menu without
changing any settings

® Modify to change settings
Select one and press <ENTER>.

MP-5823 3/98

NOTE
To save any changes at the Main Menu select Quit and
press <ENTER> to restart the software.

Program Configuration Screen Options

Company Name & Address. Type your company name,
operator name and any information required to appear on
printed reports (optional).

Port Number. Type the COM port number 1-4 for the PC’s
RS-232 serial port connected to devices the software is to
communicate with.

Touch Tone/Pulse Dialing. Type T for Tone dialing or P for
Pulse dialing.

Baud Rate. Type the baud rate used, 2400, 4800, or 9600
BPS (bits per second). The baud rate must match the baud
rate setting for every device you want the software to
communicate with. Enter this parameter at the device’s local
display and keypad under Remote Control (Menu 10 on a
Digital Controller generator set controller, Index 13 on a MATS
or MATS+ transfer switch controller, or Menu 8 on a Digital
power monitor).

Communication Fault Retries. Type in the number of
communication fault retries (from 1 to 99, 15 recommended),
the number of times the PC attempts to connect with the
selected device before displaying a communication error.

Modem Time Out. Type inthe maximum number of seconds,
from 1 to 99, that the modem takes in attempting to connect
before displaying a communication error. A modem time out of
99 seconds is recommended.

Color Monitor. Type Y (Yes) if you have a color display or N
(No) if you have a monochrome display.

Help File Path. Type the drive/path name for the helpfiles. If
you have installed the program and help files on the hard disk
as shown in this manual, type [C:\MONITOR\HELP)].
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Section 3. Generator Set Controller Data Menu

3.1 Data Menu Screen Selections Menu Item Figure Section
The software displays the generator set controller Data Status Summary Figure 3-3 33
Menu screen when it establishes communications with Setting Summary Figure 3-5 3.4
the Digital Controller. See Figure 3-1. Operational Summary Figure 3-6 35
Spectrum Monitor Data Menu <DIGCONs Designation Time of Day Setup Figure 3-7 3.6
1 and | tochoose. ENTER selects ESC Previous Menu. F1Help  F10 Main Menu. Time Delay Setup Figure 3-8 3.7
Information Setup Figure 3-9 3.8
Trip Point Setup Figure 3-10 3.9
Data Menu B User Defined Functions Figure 3-11 3.10
Status Summary Engine Start Setup Figure 3-13 3.1

Setting Summary
Operational Summary
Time of Day Setup

Time Delay Setup
Information Setup

Trip Point Setup

User Defined Functions
Engine Start Setup l

Programming Mode: REMOTE

Figure 3-1. Digital Controller Data Menu Screen

The Data Menu screen and other screens described in
this section have <DIGCON> Designation in the upper
right-hand corner. Enter the designation, an optional
descriptive name for the device, on the Information
Setup screen. See Section 3.8. These identifiers allow
you to know the type of device and its designation the
screen displays.

Figure 3-2 lists the selections that appear on the Data
Menu screen. The software also displays the current
programming mode at the bottom of the screen. If the
generator setis notin the REMOTE programming mode
(OFF or LOCAL), the Data Menu screen displays the
summary screen and user-defined functions selections
only.

MP-5823 3/98

Figure 3-2. Digital Controller Data Menu
Selections

Summary screens display generator set conditions and
settings but do not allow programming. Use the setup
screens to program the controller’s various settings and
functions.

Although you enter data in the setup screens, all data is
transferred to the controller upon update and stored in
its memory. See the generator set controller operation
and installation manual for factory default values.

Use the up arrow 1 or down arrow | key to highlight the
desired menu selection and press <ENTER> to procede
to that screen. Press the <ESC> key to return to the
Data Menu.

Regular updates occur to screen information. The COM
port baud rate determines the update frequency.

3.2 Printing Options

Press <F9> in the summary and setting screens to get
the print options menu. Use the up and down arrow keys
to select from the following options.

® Print to Printer prints a hard-copy report of the
current screen to the printer the system designates
as LPT1.

® Save Reportto a File asks to provide a name for a
file and saves the current screen report to the file.

® Review Report provides a print preview of a
screen report.
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3.3 Status Summary Screen

The Status Summary screen displays a summary of the
current status of the generator set. See Figure 3-3.

Spectrum Monitor Status Summary <DIGCON> Designation

ESC exit. F1 Help. F9 Print. F10 Main Menu.

Wednesday 03/13/1996 01:28 PM
Generator Status Running

System Alert  System Ready
Time Delays Run End Program Mode Remote
Engine Start OFF OFF | Master Switch Auto
Crank On OFF OFF
Starting Aid OFF OFF | Engine Speed 1800 RPM
Crank Pause OFF OFF | Coolant Temperature 180 °F 82 °C
Engine Cooldown OFF OFF | Oil Pressure 90 PS| 621 kPa

Battery Voltage 252 VDC
Voltage/Frequency
L1-L2 Voltage 480 VAC L1 Current 500 Amp
L2-L3 Voltage 480 VAC L2 Current 500 Amp
L3-L1 Voltage 480 VAC L3 Current 500 Amp
L1-LO Voltage 277 VAC Power Factor 0.8
L2-LO Voltage 277 VAC Total Kilowatts 333 KW
L3-LO Voltage 277 VAC % Max KW 60 %
Frequency 60.0 Hz

Figure 3-3. Status Summary Screen

Time -
Delay Indication
Run ON Delay is timing
End ON Delay has completed timing
Run OFF  Delay has not begun timing or run time has completed
End OFF  Delay has not begun timing or time delay is running

AC Voltage and Frequency (continued)
Starting Aid The engine starting aid time delay
Crank Pause The engine cyclic cranking off time
Engine Cooldown The time delay from the remote start
contacts opening to the engine stopping
Voltage The voltage on each generator set AC phase
L1-L2, L2-L3, L3-L1, L1-LO, L2-LO, and L3-LO
Frequency The generator set running frequency in hertz
(Hz)
Time Displays the current time at the generator set
controller’s location.
Day of week
Date Month/Day/Year
Time of day Hours:Minutes AM/PM
System Alert Shows the operating mode of the unit.
The message displayed can be any of the common
faults plus the following messages. See Section
3.10—User Defined Functions for a list of common
faults. See the generator set controller operation and
installation manual for more information.

Figure 3-4. Time Delays

Summary Screen Key Functions

Overvoltage L1-L2
Overvoltage L2-L3
Overvoltage L3-L1
Overvoltage L1-LO
Overvoltage L2-L0
Overvoltage L3-L0
Undervoltage L1-L2

Undervoltage L2-L3
Undervoltage L3-L1
Undervoltage L1-L0
Undervoltage L2-L0
Undervoltage L3-L0
Master Switch Open
Power-Down Error

Key Screen Function

ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F9 Print Displays the print menu

F10 Main Menu Returns to the Main Menu

Status Summary Screen Information

Generator Status Shows the generator set status:
Running, Stopped, or Cranking.

Time Delays Set time delay options on the Time Delay
Setup screen. See Figure 3-8.

AC Voltage and Frequency Displays voltage and
frequency readings for AC power.
Engine Start The time delay from the remote start
contacts closing to the engine start sequence beginning.
The engine start time delay is active only when the
generator set has been started using automatic remote
start.

Crank On The engine cranking on time

18 Generator Set Controller Data Menu

Program Mode Shows the current programming
mode: Local, Off, or Remote.

Master Switch Shows the master switch position:
RUN, OFF/RESET, or AUTO.
Engine Operating Conditions

Engine Speed The engine speed in RPM

Coolant Temperature The engine coolanttemperature in
degrees Fahrenheit and Celsius

Oil Pressure The engine oil pressure in PSI and kPa

Battery Voltage The voltage of the starting battery(ies)
AC Current and Power Displays current and power
readings for AC power.

L1, L2, L3 Current The amperage readings for Linet,
Line 2, and Line 3

Power Factor The power factor
Total Kilowatts The total generator load in kilowatts

% of Max KW The current kW loading on the generator
divided by the kW rating
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3.4 Setting Summary Screen

The Setting Summary screen displays the current

settings for the generator set. See Figure 3-5.

Spectrum Monitor

Setting Summary

<DIGCON> Designation

ESC exit. F1 Help. F9 Print. F10 Main Menu.

Trip Points
Overvoltage 12 % 537 VAC
Undervoltage 94 % 451 VAC
Over Frequency 140 %  84.0 Hz
Under Frequency 94 %  56.4 Hz
Over Speed 2100 RPM 70 Hz

Wednesday 03/13/1996 01:28 PM

Time Delays MN:SC
Engine Start 00:15
Crank On 00:01
Crank Pause 00:04

Low Battery Voltage 23.4 VDC| Number of Crank Cycles 2
High Battery Voltage 29.8 VDC| Engine Cooldown 00:00
Overvoltage 00:02
Generator Information Undervoltage 00:05
System Voltage 480 VAC Starting Aid 00:08
System Frequency 60 Hz
Single/Three Phase 3 WYE Inhibit  Delay
KW Rating 1200 Auxiliary 1 00:00 00:00
Battery Voltage 24 VDC Auxiliary 2 00:00 00:00
Network Address 3 Auxiliary 3 00:00 00:00
Load Test load bank no. 1 Auxiliary 4 00:00 00:00
Location No. side of bldg. 32

Model No. 000
Spec No. 000

Serial Number 000000
Control Serial Number C000000

Figure 3-5. Setting Summary Screen

Summary Screen Key Functions

Key Screen

Function

Returns to the previous menu or screen

Setting Summary Screen Information

Trip Points Trip points are the settings at which the unit
shuts down or displays a fault condition. See the
generator set controller operation and installation
manual for details on fault diagnostics.

Overvoltage The percent of system voltage that causes
the unit to shut down after the presettime delay. Enter the
overvoltage percent on the Trip Point Setup screen. See
Figure 3-10. Enterthe time delay onthe Time Delay Setup
screen. See Figure 3-8.

Undervoltage The percent of system voltage that causes
the unit to shut down after the presettime delay. Enter the
undervoltage percent on the Trip Point Setup screen. See
Figure 3-10. Enterthe time delay onthe Time Delay Setup
screen. See Figure 3-8.

Over Frequency The percent of system frequency that
causes the unit to shut down after ten seconds. Enter the
overfrequency percent on the Trip Point Setup screen.
See Figure 3-10.

Under Frequency The percent of system frequency that
causes the unit to shut down after ten seconds. Enterthe
underfrequency percent on the Trip Point Setup screen.
See Figure 3-10.

Over Speed The rotational speed in RPM and frequency

ESC Exit
F1 Help
Fo Print

F10 Main Menu

Displays the help screen
Displays the print menu
Returns to the Main Menu

that shuts the unit down immediately. Enter the overspeed
frequency on the Trip Point Setup screen. See
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Figure 3-10.

Low Battery Voltage The level that battery voltage must
be below for more than 10 seconds to cause a low battery
voltage warning. Enter the low battery voltage on the Trip
Point Setup screen. See Figure 3-10.

High Battery Voltage The level that battery voltage must
be above for more than 10 seconds to cause a high battery
voltage warning. Enterthe high battery voltage on the Trip
Point Setup screen. See Figure 3-10.
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Setting Summary Screen Information
(continued)

Generator Information

System Voltage The generator set voltage shown on the
nameplate.

System Frequency The generator set frequency shown
on the nameplate.

Single/Three Phase Voltage configuration, single- or
three-phase and, if three-phase, the type of connection
(delta or wye). Phase and voltage are shown on the
nameplate.

KW Rating The generator set standby kilowatt rating
shown on the nameplate.

Battery Voltage The battery voltage shown on the
nameplate.

Network Address Displays the current address of the unit
on an RS-485 network. Set at the local display and
keypad.

Load An optional description of the connected load, such
as total building, HVAC motors, etc., entered on the
Information Setup screen. See Figure 3-9.

Location An optional description of the generator set's
physical location entered on the Information Setup screen.
See Figure 3-9.

Model No. The generator set model numbershown onthe
nameplate.

Spec No. The generator set specification number shown
on the nameplate.

Serial Number The generator set serial number shown on
the nameplate.

Control Serial Number The generator set controller serial
number.

20 Generator Set Controller Data Menu

Time Displays the current time at the generator set
controller’s location.

Day of week

Date Month/Day/Year

Time of day Hours:Minutes AM/PM
Time Delays Time delays are the time in minutes and
seconds that will cause the unit to shut down or display a
fault condition.

Engine Start The engine starttime delay. The engine start
time delay is active only when the generator set has been
started from a remote location.

Crank On The engine cranking on time
Crank Pause The engine cyclic cranking rest time

Number of Crank Cycles The number of engine crank
cycles before shutdown

Engine Cooldown The engine cooldown time delay
Overvoltage The overvoltage time delay
Undervoltage The undervoltage time delay

Starting Aid The engine starting aid time delay. It allows
adjustments to the starting aid RDO on time before engine
cranking.

Auxiliary 1,2, 3, 4
Inhibit The time in minutes:seconds after engine starting
before the respective auxiliary 1, 2, 3, 4 inputs is checked.

Delay Thetimein minutes:seconds after a sensor signal is
received before a shutdown or warning occurs for auxiliary
1,2,3,4.
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3.5 Operational Summary Screen

The Operational Summary screen displays information
about the generator set operation. See Figure 3-6.

Spectrum Monitor Operational Summary <DIGCON> Designation

ESC exit. F1 Help. F9 Print. F10 Main Menu.

Operational Status Reset Total | Wednesday 03/13/1996 01:28 PM
Run Time: Loaded 0.0 0.0 | Last Start ——m=—
Run Time: Unloaded 0.0 0.0 [ Durationof Run 0 HRS 0 MIN
KW Hours 0 0| Loaded/Unloaded UNLOADED
Days Operation 0 0

Number of Starts 0 0

Start Date === === [==

Generator Shutdown History Date

1 Emergency Stop 03/13/1996

2 None ——fmm|==

3 None ——fm==

4 None ——[=—

Figure 3-6. Operational Summary Screen

Summary Screen Key Functions

Key Screen Function

ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F9 Print Displays the print menu

F10 Main Menu Returns to the Main Menu
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Operational Summary Screen Information
Operational Status: Reset and Total

The reset column displays information about generator
set operation since the last time the record was reset.
The reset can only be performed at the controller.

The total column displays generator set operation
record totals since the initial installation of the generator
set and/or controller.

Run Time: Loaded The running time of the generator set
with a load

Run Time: Unloaded The running time of the generator
set without a load

KW Hours The number of kilowatt hours on the generator
set

Days Operation The number of days the generator set
has been in operation
Number of Starts The number of successful starts for the
generator set
Start Date The lastrecord-reset date and the date thatthe
controller was installed.
Time Displays the current time at the generator set
controller location.
Day of week
Date Month/Day/Year
Time of day Hours:Minutes AM/PM
Generator Shutdown History Displays a history ofthe
four most recent generator set shutdowns and the date
on which they occurred.
Last Start The time and date the generator set was last
successfully started.
Duration of Run The time in hours:minutes that the
generator set last ran.

Loaded/Unloaded Whether the last run time was with
or without a load.
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3.6 Time of Day Setup Screen

Use the Time of Day Setup screento set the currenttime
and date at the generator set controller’s location. See
Figure 3-7.

Spectrum Monitor Time of Day Setup  <DIGCON> Designation

ESC exit. F1 Help. F4 Update. F9 Print. F10 Main Menu.

Device Site Present Setup

Time 03:27 PM

Date 03/13/1996
Wednesday

Figure 3-7. Time of Day Setup Screen

Setup Screen Key Functions

Key Screen Function
1 Moves the cursor up to choose
| Moves the cursor down to choose
ENTER Enters a value at the cursor position
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F4 Update Updates and stores the new settings
F9 Print Displays the print menu
F10 Main Menu  Returns to the Main Menu

22 Generator Set Controller Data Menu

NOTE
If setting the time for a generator set controller located in
a different time zone, enter the time to match the time
zone at the generator set controller’s location.

Time of Day Setup Screen Information

Time Thetime at the generator set controller’s location,
format HR:MN AM or HR:MN PM

Date The date at the generator set controller’s location,
format MO/DY/YEAR. The software automatically
calculates the day of the week from the date upon
update and displays it under the date.

The Present column displays the existing settings.
Make changes in the Setup column.

Use the arrow keys to move the cursor to the desired
location in the setup column.

Type the changes in the setup column; press <ENTER>
or the down arrow key to proceed to the next line. Press
<F4> to update the record and store the changes.
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3.7 Time Delay Setup Screen

Use the Time Delay Setup screen to set time delays in
minutes:seconds for various functions. See Figure 3-8.

Spectrum Monitor Time Delay Setup <DIGCON> Designation

ESC exit. F1 Help. F4 Update. F9 Print. F10 Main Menu.

Present Setup Limits
Engine Start 00:15 00:15 00:00-05:00
Crank On 00:15 00:01 00:01-00:45
Crank Pause 00:15 00:04 00:01-01:00
Number of Crank Cycles 2 2 1-6
Engine Cooldown 00:00 00:00 00:00-10:00
Overvoltage 00:02 00:02 00:02-00:10
Undervoltage 00:05 00:05 00:05-00:30
Starting Aid 00:08 00:08 00:00-00:10
Auxiliary 1 Inhibit 00:00 00:00 00:00-01:00
Delay 00:00 00:00 00:00-01:00
Auxiliary 2 Inhibit 00:00 00:00 00:00-01:00
Delay 00:00 00:00 00:00-01:00
Auxiliary 3 Inhibit 00:00 00:00 00:00-01:00
Delay 00:00 00:00 00:00-01:00
Auxiliary 4 Inhibit 00:00 00:00 00:00-01:00
Delay 00:00 00:00 00:00-01:00

Figure 3-8. Time Delay Setup Screen

Setup Screen Key Functions

Key Screen Function
1 Moves the cursor up to choose
| Moves the cursor down to choose
ENTER Enters a value at the cursor position
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F4 Update Updates and stores the new settings
F9 Print Displays the print menu
F10 Main Menu  Returns to the Main Menu

Setup Screen Column Headings

Column Purpose
Present  Current settings
Setup Make changes here

o The software accepts inputs only within the
Limits e

range of these limits.
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Time Delay Setup Screen Information

Engine Start The time delay between the remote start
contacts closing and the engine start sequence
beginning

Crank On The engine cranking-on time

Crank Pause The engine cyclic cranking rest time

Number of Crank Cycles The number of engine crank
cycles before overcrank shutdown
Engine Cooldown Thetime delay between the remote
start contacts opening and the engine stop sequence
Overvoltage The time delay before a fault if an
overvoltage condition exists
Undervoltage The time delay before a fault if an
undervoltage condition exists
Starting Aid The engine starting aid time delay. It
allows adjustment to the starting aid RDO on time
before engine cranking.
Auxiliary 1,2, 3, 4
Inhibit The time after engine starting before the respective
auxiliary 1, 2, 3, 4 inputs is checked.

Delay The time after a sensor signal is received before
shutdown or warning occurs for auxiliary 1, 2, 3, 4.

The Present column displays the existing settings.
Make changes in the Setup column.

Use the arrow keys to move the cursor to the desired
location in the setup column.

Type the changes; press <ENTER> or the down arrow
key to proceed to the next line. Press <F4> to update
the record and store the changes.
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3.8 Information Setup Screen

Use the Information Setup screen to enter generator set
information. This information is normally entered only at
time of system installation and/or initial startup. See
Figure 3-9.

Spectrum Monitor Information Setup  <DIGCON> Designation

ESC exit. F1 Help. F4 Update. F9 Print. F10 Main Menu.

Present Setup
System Voltage 480 VAC
System Frequency 60 Hz
%’r:;;le/Three Phase 3 WYE

Rating 1200
Battery Voltage 12VDC
Designation Designation
Load Test load bank no. 1 Load
Location No. side of bildg. 32 Location
Model No. 000
Spec No. 012345
Serial No. 000000
Control Serial Number C000000
Network Address 3

Figure 3-9. Information Setup Screen

Setup Screen Key Functions

Key Screen Function
1 Moves the cursor up to choose
| Moves the cursor down to choose
ENTER Enters a value at the cursor position
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F4 Update Updates and stores the new settings
F9 Print Displays the print menu
F10 Main Menu  Returns to the Main Menu
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Information Setup Screen Information

System Voltage The generator set voltage shown on
the nameplate. This setting is factory set.

System Frequency The generator set frequency
shown on the nameplate. This setting is factory set.

Single/Three Phase Voltage configuration, single- or
three-phase and, if three-phase, the type of connection
(delta or wye). Phase and voltage are shown on the
nameplate. This setting is factory set.

KW Rating The generator set kilowatt rating shown on
the nameplate. This setting is factory set.

Battery Voltage The battery voltage shown on the
nameplate. This setting is factory set.

Designation An optional entry of a unique name
describing location, function, etc. You can enter aname
of up to 9 characters.

Load An optional description of connected load, such
as total building, HVAC, motors, etc. You can enter a
description of up to 20 characters.

Location An optional description of the generator set’s
physical location. You can enter a description of up to 20
characters.

Model No. The generator set model number shown on
the nameplate.

Spec No. The generator set specification number
shown on the nameplate.

Serial No. The generator set serial number shown on
the nameplate.

Control Serial Number The generator set controller
serial number.

Network Address The current address of the unit on
an RS-485 network. Set at the local display and keypad.

The Present column displays the existing settings.
Make changes in the Setup column.

Use the arrow keys to move the cursor to the desired
location in the setup column.

Type the changes, press <ENTER> or the down arrow
key to proceed to the next line. Press <F4> to update
the record and store the changes.
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3.9 Trip Point Setup Screen

Use the Trip Point Setup screen to enter the settings at
which the unit shuts down or displays a fault condition.
See Figure 3-10.

Spectrum Monitor Trip Point Setup <DIGCON> Designation

ESC exit. F1 Help. F4 Update. F9 Print. F10 Main Menu.

Present Setup Limits

Qvervoltage 112 % 537 VAC [112 % 537 VAC 105-135%
Undervoltage 94 % 451 VAC 94 % 451 VAC 70-95%
Qver Frequency 140 % 84.0 Hz 140 % 84.0 Hz 102-140%
Under Frequency 94 % 56.4 Hz 94 % 56.4 Hz 80-98%
Over Speed 70 Hz 2100 RPM 70 Hz 2100 RPM 65-70 Hz on 60 Hz
55-70 Hz on 50 Hz

Low Battery Voltage 23.4 VDC 23.4 VDC 10.0-12.5 VDC (12V)
20.0-25.0 VDC (24V)

High Battery Voltage 29.8 VDC 29.8 VDC 14.5-16.5 VDC (12V)

29.0-33.0 VDC (24V)

Figure 3-10. Trip Point Setup Screen

Setup Screen Key Functions

Key Screen Function
1 Moves the cursor up to choose
| Moves the cursor down to choose
ENTER Enters a value at the cursor position
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F4 Update Updates and stores the new settings
F9 Print Displays the print menu
F10 Main Menu  Returns to the Main Menu

Setup Screen Column Headings

Column Purpose
Present  Current settings
Setup Make changes here
o The software accepts inputs only within the
Limits e
range of these limits.
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Information Setup Screen Information

Overvoltage The percent of system voltage that shuts
down the unit.

Undervoltage The percent of system voltage that
shuts down the unit.

Over Frequency The percent over nominal frequency
for more than 10 seconds that causes the unit to shut
down.

Under Frequency The percent under nominal
frequency for more than 10 seconds that causes the unit
to shut down.

Over Speed The speed that shuts the unit down
immediately.

Low Battery Voltage The level the battery voltage
must drop below for more than 10 seconds to cause a
low battery voltage warning.

High Battery Voltage The level the battery voltage

must rise above for more than 10 seconds to cause a
high battery voltage warning.

The Present column displays the existing settings.
Make changes in the Setup column.

Use the arrow keys to move the cursor to the desired
location in the setup column.

Type the changes; press <ENTER> or the down arrow
key to procede to the next line. Press <F4> to update
the record and store the changes.
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3.10 User Defined Functions Screen

Use the User Defined Functions screen to change the
names and functions of auxiliary 1-4, associate
functions with relay driver outputs, and select conditions
that trigger a defined common fault. See Figure 3-11.

Spectrum Monitor User Defined Functions <DIGCON> Designation

ESC exit. F1 Help. F4 Update. F9 Print. F10 Main Menu.

Present Setup
Auxiliary 1 Fuel Leak WARNING Fuel Leak WARNING
Auxiliary 2 Door Open SHUTDOWN  Low Air Flow SHUTDOWN

Auxiliary 3 Overtemp SHUTDOWN  Overtemp SHUTDOWN
Auxiliary 4 Undertemp SHUTDOWN  Undertemp SHUTDOWN
B ReIaX Driver Outputs
1 ir Damper Low Coolant Level

6
2 Under Freq Shutdown 7 Ground Fault Detected
3 High Battery Voltage 8 Generator Running
4 No Oil Gauge Signal 9 Locked Rotor

5 NFPA 110 Common Alarm 10 Defined Common Fault

- Common Fault Selections Active
Low Coolant Level Yes
High Oil temperature Yes
Engine Start Yes
Generator Running Yes
Air Damper No
Over Voltage No
Under Voltage No

Figure 3-11. User Defined Functions Screen

Spectrum Monitor User Defined Functions <DIGCON> Designation

ESC exit. F1 Help. F4 Update. F9 Print. F10 Main Menu.

Present Sat
Auxiliary 1 Fuel Lea Relay Driver Output 1 WARNING
Auxiliary 2 Door Op fjiv SHUTDOWN
Auxiliary 3 Overtemy Defined Common Fault SHUTDOWN
Auxiliary 4 Underten|  Air Damper SHUTDOWN
— ReIaX Driver Outputs| Over Voltage
1 | Air Damper Under Voltage evel

2 Under Freq Shul Under Frequency Detected
3 High Battery Vol High Oil Temperature ning

4 No Oil Gauge Si| Auxiliary 1
5 NFPA 110 Comn| Auxiliary 2
— Common Fault Selec] Auxiliary 3
Low Coolant | Auxiliary 4

High Oil tempq  Locked Rotor

on Fault

Engine Start Internal Error

Generator Ru{  EPS Supplying Load H
Air Damper Speed Sensor Fault |
Over Voltage ™o

Under Voltage No

Figure 3-12. Relay Driver Output Popup Menu

Setup Screen Key Functions

Key Screen Function
1 Moves the cursor up to choose
| Moves the cursor down to choose
ENTER Enters a value at the cursor position
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F4 Update Updates and stores the new settings
F9 Print Displays the print menu
F10 Main Menu  Returns to the Main Menu
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User Defined Functions Screen
Information

Auxiliary 1, 2, 3,4 Program the identifying name that
causes a warning or shutdown on auxiliary 1, 2, 3, or 4.
Type the new name and press <ENTER>to move tothe
next column. Type W to program a WARNING or S to
program a SHUTDOWN.

The Present column displays the existing settings.
Make changes in the Setup column.

Use the arrow keys to move the cursor to the desired
location in the setup column.

Relay Driver Outputs Relay Driver Outputs identify a
signal source for each of the ten relay driver outputs.
Highlight one of the relay driver outputs 1-10 on the User
Defined Functions screen and press <ENTER> to
display the Relay Driver Output popup menu. See
Figure 3-12. In the Relay Driver Output popup menu,
use the up/down arrow keys to scroll through the
following list of signal sources:

Defined Common Fault Load Shed

Air Damper KW Overload

Over Voltage Under Freq[uency] Warning
Under Voltage High Battery Voltage

Under Freq[uency] No Temp[erature] Gauge

Shutdown Signal
Low Coolant Level No Oil Gauge Signal

High Oil Temperature Ground Fault Detected

Auxiliary 1 Over Current

Auxiliary 2 Engine Cooldown
Auxiliary 3 Engine Start

Auxiliary 4 Generator Running
Locked Rotor NFPA 110 Common Alarm
Internal Error Starting Aid

EPS Supplying Load
Speed Sensor Fault

Weak Battery
Low AC Output
Over Frequency Shutdown

Press <ENTER> to assign the highlighted option to the
relay driver output. Move to the next Relay Driver
Output 1-10 on the User Defined Functions screen and
press <ENTER> to display the popup menu again.
Repeat the process to designate signal sources for all
ten relay driver outputs.
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User Defined Functions Screen
Information (continued)

Common Fault Selections Select conditions that
trigger the defined common fault signal. The choices
include those signals available for the relay driver
outputs listed above plus the following:

Low Oil Pressure Battery Charger Fault

High Coolant Temp[erature] Low Fuel

Over Crank High [Coolant] Temp Warning
Over Speed Low Oil Press[ure] Warning
Emergency Stop Load Shed Under Freq[uency]
Not In Auto Low Coolant Temp[erature]

System Ready Load Shed Excess KW

Low Battery Voltage

Use the up and down arrow keys to move through the
list. TypeY to change to Active—Yes or N to change to
Active—No. When any of the Active—Yes selections
occur, the Defined Common Fault signal becomes
active.

After updating the information, the selections
designated as Active-Yes appears before any Active-No
selections.
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Type the changes; press <ENTER> or the down arrow
key to proceed to the next line. Press <F4> to update
the record and store the changes.

Pressing the <ESC> key to exit this screen after making
changes to the information without updating the
changes causes the program to ask whether you want
to exit without making the changes. Reply yes or no.
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3.11 Engine Start Setup Screen

Use the Engine Start Setup screen to start the generator
set and run it for a specified time period.
See Figure 3-13.

Spectrum Monitor Engine Start Setup  <DIGCON> Designation

ESC exit. F1 Help. F4 Update. F8 STOP Engine. F9 Print. F10 Main Menu.

Present Setup  Limits
Run Time 00:00 00:000 0-72:00 HR:MN
Generator Status STOPPED
System Alert Not in Auto
Fault Reset NO

Figure 3-13. Engine Start Setup Screen

Setup Screen Key Functions

NOTE
This screen allows the software operator to start and run
a generator setin a location that is not within sight of the
operator. Use extreme care when using this feature to
prevent accidental starting of the generator set.

Key Screen Function
1 Moves the cursor up to choose
| Moves the cursor down to choose
ENTER Enters a value at the cursor position
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F4 Update Updates and stores the new settings
F8 2:;35 e Stops the exerciser mode
F9 Print Displays the print menu
F10 Main Menu  Returns to the Main Menu

Setup Screen Column Headings

Column Purpose

Present  Current settings

Setup Make changes here

Limits The software accepts inputs only within the

Engine Start Setup Screen Information
Run Time Displays the generator set run time.

To set the run time and start the generator set, proceed
as follows:

1. Position the cursor in the Run Time row, Setup
column.

2. Typetheruntimein hours:minutes. The generator
set stops after the set time expires. Maximum time
is 72:00 (72 hours).

3. Ifafault exists at the generator set and you want to
reset it to run, type Y to change the fault reset to
Yes.

4. After making the desired choices, press <F4>,
confirm with Y and press <ENTER> to start the
generator set. The time you designate as run time
moves from the Setup column to the Present
column.

NOTE: Press <F8> to stop the test before the run time
completes.

The run time setting returns to 00:00/NO after the
exerciser run time is complete.

Generator Status Shows the generator set status:
Running, Stopped, or Cranking.

System Alert Shows the current status of the generator
set. See Section 3.3 for details.

Fault Reset Displays the fault reset condition. If a fault
exists, reset the fault before exercising the generator
set.

range of these limits.
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Section 4. ATS Controller Data Menu

4.1 Data Menu Screen Selections

The software displays the ATS Data Menu screen when
it establishes communications with an automatic
transfer switch (ATS) controller. See Figure 4-1.

The screens and menus associated with the MATS and
MATS+ transfer switch controls are similar, with the
MATS+ having the additional functions associated with
programmed transition. For clarity, only the MATS+ is
discussed here with the differences noted.

Spectrum Monitor Data Menu <MATS+> Designation

1 and | to choose. ENTER selects ESC Previous Menu.  F1Help  F10 Main Menu.

Data Menu 1

Status Summary

Switch Setting Summary
Plant Exerciser Summary
Time of Day Setup

Time Delay Setup
Information Setup

Trip Point Setup

Load Shed Setup

Plant Exerciser Setup
Engine / Start Setup |

Plant Exerciser: ENABLED Programming Mode Switch: REMOTE

Figure 4-1. ATS Data Menu Screen, MATS+ Shown

The Data Menu screen and other screens described in
this section have <MATS+> Designation in the upper
right-hand corner. Enter the Designation, an optional
descriptive name for the device, on the Information
Setup screen (see Section 4.11). These identifiers allow
you to know the type of device and its designation the
screen displays. For an MATS transfer switch, the
screen actually shows <MATS> Designation.

Figure 4-2 lists all the selections that can appear on the
Data Menu screen. The software shows the Plant
Exerciser mode: ENABLED or DISABLED and the
position of the Programming Mode Switch at the bottom
of the screen. The position of the Programming Mode
Switch determines the current programming mode:
REMOTE, OFF, or LOCAL. If the ATS is not in the
REMOTE programing mode (OFF or LOCAL), the Data
Menu screen displays the summary screen selections
only.

The Plant Exerciser mode must be ENABLED in order
for the software to show the Plant Exerciser Summary,
Plant Exerciser Setup, or Engine Start Setup screens.
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Menu ltem Figure Section
Status Summary Figure 4-3 4.3
Switch Setting Summary Figure 4-4 4.4
Plant Exerciser Summary Figure 4-5 45-438
Time of Day Setup Figure 4-11 4.9
Time Delay Setup Figure 4-12 4.10
Information Setup Figure 4-13 411
Trip Point Setup Figure 4-14 412
Load Shed Setup Figure 4-15 413
Plant Exerciser Setup Figure 4-16 | 4.14-4.17
Engine Start Setup Figure 4-20 418

Figure 4-2. ATS Data Menu Selections

Summary screens display transfer switch conditions
and settings but do not allow programming. Use the
setup screens to program the controller’'s various
settings and functions.

Although you enter data in the setup screens, all data is
transferred to the controller upon update and is stored in
its memory. See the ATS controller operation and
installation manual for factory default values.

Use the up arrow 1 or down arrow | key to highlight the
desired menu selection and press <ENTER> to proceed
to that screen. Press the <ESC> key to return to the
Data Menu.

Regular updates occur to screen information. The COM
port baud rate determines the update frequency.

4.2 Printing Options

Press <F9> in the summary and setting screens to get
the print options menu. Use the up and down arrow keys
to select from the following options.

® Print to Printer prints a hard-copy report of the
current screen to the printer the system designates
as LPT1.

® Save Reportto a File asks to provide a name for a
file and saves the current screen report to the file.

® Review Report provides a print preview of a
screen report.
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4.3 Status Summary Screen

See Figure 4-3 for an example of the Status Summary
screen.

Spectrum Monitor Status Summary <MATS+> Designation
Switch Position NORMAL 07/31/1996  Wednesday 08:07 PM
Sources Available  NORMAL - System Alert NONE
Program Mode ~ REMOTE
Time Delays Run End Test Switch AUTO
Engine Start OFF OFF
Normal to Emergency ~ OFF OFF Accessories Active Status
Emergency to Normal ~ OFF OFF | Plant Exerciser OFF
Engine Cooldown OFF OFF | Load Shed OFF
Off Position OFF OFF | In-Phase Monitor DISABLED
Area Protection OFF
Operational Status Reset Total
Hours-Not In Normal 0 0 Transfer Status
Hours-Emer. Source 0 0 | Exerciser Time Left 0 hrs 0 min
Days-Operation 0 0 | Last Exerciser Date 01/02/1995
Switch Transfers 0 0 | Last Outage 11:34 AM  01/15/1995
Start Date 02/08/1996 11/08/1990 | Duration of Outage 0 hrs 0 min
Auto / Manual Transfer AUTO
Voltage/Frequency ~ Normal Emergency
Phase A-B Voltage - - Source History Date
Phase B-C Voltage - - #1 NORMAL UNDER-FREQUENCY 01/15/1996
Phase A-C Voltage - - #2 NORMAL UNDER-FREQUENCY 12/05/1995
Phase A-C Frequency 0.0 0.0 #3 NORMAL UNDER-FREQUENCY 09/25/1995
Phase Sequence - - #4 NORMAL UNDER-FREQUENCY 08/12/1995
F1 -Help. F9 -Print. F10 - Main Menu. ESC - previous menu.

Figure 4-3. Status Summary Screen

Summary Screen Key Functions

Key Screen Function

ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F9 Print Displays the print menu

F10 Main Menu Returns to the Main Menu
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Status Summary Screen Information

Switch Position Position of the transfer switch
contactor—NORMAL, EMERGENCY, or OFF. The
OFF position applies only to the MATS+ controller.

Source Available Which sources—NORMAL and/or
EMERGENCY can accept loads.

Time Delays Time delay indications match the LED
indications at the transfer switch. The Off Position delay
item displays only for the MATS+ controller.

Run ON Delay is timing.

End ON Delay has completed timing.

Run OFF Delay has not begun timing or run time has

completed.

End OFF Delay has not begun timing or time delay is

running.
Operational Status The Reset column displays
information since the last record reset. The Total
column displays information since installation of the
transfer switch and/or controller:

Hours—Not in Normal The number of hours that the

switch has not been in the Normal position.

Hours—Emer. Source The number of hours that the
emergency source has been available.
Days—Operation The number of days that the ATS
controller has been in operation.

Switch Transfers The number of times that the switch
contactor has operated.

Start Date The date of last record reset and the date of
transfer switch or controller installation.

Voltage/Frequency

Voltage(s) Shown for each phase of normal and
emergency sources when available. A single-phase
source shows voltage on phase A-C.

Frequency Shown for phase A-C of each source, if
available.

Phase Sequence Shown for each available source (for
3-phase only).
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Status Summary Screen Information
(continued)

Time Displays the current time at the ATS controller
location. (Time appears across the top of the screen for the
MATS controller.)

Date Month/Day/Year

Day of week

Time of day Hours:Minutes AM/PM

Day Occurs # The occurrence number of the day in the

current month 1-5 (displays only for the MATS controller.)
See Calendar Mode for more explanation.

System Alert
NONE The ATS controller and contactor are working
properly.
AUX-SWITCH FAULT A contactor auxiliary switch contact
malfunction, wiring, or controller fault.
DBL AUX-SW FAULT A contactor auxiliary switch contact
malfunction, showing both normal and emergency
contacts closed at the same time or other wiring or
controller fault.

TRANSFER HANG The contactor may be binding or not
completing a transfer.

POWER DOWN ERROR May indicate a loss of controller
settings after a loss of controller power. Recheck settings
and reenter as necessary.

RAM ERROR, MEMORY ERROR An ATS controller
random access memory fault after controller powerup.
The controller may require replacement.

MANUAL TRANSFER Manual transfer is needed when
the Auto-Manual selector switch if equipped is in the
MANUAL position. Push the MANUAL TRANSFER TO
(NORMAL, EMERGENCY, or OFF) push button as
necessary.

FAULT #1, FAULT #2 Shows system faults external to the
ATS controller. Connection of the two fault-sensing circuits
is optional and may be used to annunciate generator set
conditions.

Program Mode The programming mode determined
by the position of the programming mode switch on the
transfer switch front panel—Remote, Off, Or Local.
Test Switch The position of the system test switch
and/or the auto-manual switch—AUTO or NOT IN
AUTO.
Accessories Active Status The Accessories Active
Status matches the Accessory Active LEDs on the ATS
controller.

ON The accessory is functioning.

OFF The accessory has completed its function or has not

been called upon to function.

DISABLED The enabling shunt on the controller circuit board
is not installed. The accessory is not enabled.
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Transfer Status.

Exerciser Time Left The generator set running time
(hours and minutes) remaining when the generator set is
running in plant-exercise or engine start mode.

Last Exerciser Date The date of the most recent
plant-exercise run.

Last Outage The time and date of the most recent normal
source outage or test using the system test switch.

Duration of Outage The length (hours and minutes) ofthe
most recent normal source outage or test using the system
test switch. Outage durations of less than one minute do
not show on the screen.

Auto/Manual Transfer The position, AUTO or MANUAL,
of the auto-manual transfer mode selector switch.

Source History The source, type, and date of the four
most recent source failures. A manual test at the
transfer switch records as a source failure.

The following fault messages are displayed for a
three-phase electrical system:

PH[ASE] A-B NORMAL OVERVOLTAGE
PH[ASE] B-C NORMAL OVERVOLTAGE
PH[ASE] A-C NORMAL OVERVOLTAGE
PH[ASE] A-B NORMAL UNDERVOLTAGE
PH[ASE] B-C NORMAL UNDERVOLTAGE
PH[ASE] A-C NORMAL UNDERVOLTAGE
NORMAL OVERFREQUENCY

NORMAL UNDERFREQUENCY

NORMAL PHASE LOSS

PH[ASE] A-B EMERGENCY OVERVOLTAGE
PH[ASE] B-C EMERGENCY OVERVOLTAGE
PH[ASE] A-C EMERGENCY OVERVOLTAGE
PH[ASE] A-B EMERGENCY UNDERVOLTAGE
PH[ASE] B-C EMERGENCY UNDERVOLTAGE
PH[ASE] A-C EMERGENCY UNDERVOLTAGE
EMERGENCY OVERFREQUENCY
EMERGENCY UNDERFREQUENCY
EMERGENCY PHASE LOSS

The following fault messages are displayed for a
single-phase electrical system:

NORMAL OVERVOLTAGE
NORMAL UNDERVOLTAGE
NORMAL OVERFREQUENCY
NORMAL UNDERFREQUENCY
EMERGENCY OVERVOLTAGE
EMERGENCY UNDERVOLTAGE
EMERGENCY OVERFREQUENCY
EMERGENCY UNDERFREQUENCY
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4.4 Switch Setting Summary Screen

See Figure 4-4 for an example of the Switch Setting

Summary screen.

Spectrum Monitor — Switch Setting Summary — <MATS+> Designation

Trip Points Normal ~ Emergency| 07/31/1996  Wednesday 08:07 PM
Overvolt Dropout 115 % 115 %
Qvervolt Pickup 110 % 110 % Time Delays MN:SC
Undervolt Pickup 90 % 90 % Engine Start 00:05
Undervolt Dropout 85 % 85 % Normal to Emergency 00:05
Qverfreq Dropout 115 % 115 % Off to Emergency 00:00
Qverfreq Pickup 110 % 110 % Emergency to Normal 00:05
Underfreq Pickup 90 % 90 % Off to Normal 00:00
Underfreq Dropout 85 % 85 % Engine Cooldown 00:05
ATS Information Normal Emergency | Load Shed Normal Emergency
System Voltage 120 VAC 120 VAC | Time Before 00:00 00:00 MN:SC
System Frequency ~ 60.0 Hz  60.0 Hz | Time After 00:00 00:00 MN:SC
Single/Three Phase 1 1 Time Sequence 00:00  00:00 MN:SC
Amperage 30 Poles 2 Load Returns 1 1 Loads
Address 1
Load LITTLE ONE In-Phase Monitor ENABLED
Branch  AIR MAKEUP Phase Sequence ENABLED
Location  SOUTH 1 N/E Over/Under V&F ENABLED
Options ~ 06B, 08C, 08D, 05K Plant Exerciser ENABLED
Time Delay Extended ENABLED
ATS Type Zenith With Off Position Manual Override ENABLED
ATS SN K000000 Control SN C000000 | Time Delay Off ENABLED

F1 -Help. F9 -Print. F10 - Main Menu. ESC - previous menu.

Figure 4-4. Switch Setting Summary Screen

Summary Screen Key Functions

Key Screen Function
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen

F9 Print Displays the print menu
F10 Main Menu Returns to the Main Menu

Switch Setting Summary Screen
Information

Trip Points for Normal and Emergency sources:

Overvolt Dropout The percentage of system line-to-line
voltage at which source is considered to be unavailable.

Overvolt Pickup The percentage of system line-to-line
voltage below which source is available.

Undervolt Pickup The percentage of system line-to-line
voltage above which source is available.

Undervolt Dropout The percentage of system line-to-line
voltage at which source is unavailable.

Overfreq Dropout The percentage of system frequency
above which source is unavailable.

Overfreq Pickup The percentage of system frequency
below which source is available.

Underfreq Pickup The percentage of system frequency
above which source is available.

Underfreq Dropout The percentage of system frequency
below which source is unavailable.
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ATS Information for Normal and Emergency sources:

System Voltage The rated line-to-line voltages of both
sources. System voltage is factory set.

System Frequency The rated frequencies of both
sources. System frequency is factory set.

Single/Three Phase The phase connections of both
sources. Single/three phase information is factory set.

Amperage The ampere rating of the transfer switch
contactor. Amperage is factory set.

Poles The number of contactor poles (4-pole may also be
designated as 3-pole with overlapping neutral). The
number of contactor poles is factory set.

Address Displays the current address of the unit if on an
RS-485 network. Set at the local display and keypad.

Load An optional general description of the load
connected to the transfer switch entered by the installerin
Information Setup. See Figure 4-13.

Branch An optional description of the branch circuit
connected to the transfer switch entered by the installerin
Information Setup. See Figure 4-13.

Location An optional description of the transfer switch’s
physical location entered by the installer in Information
Setup. See Figure 4-13.

Options The catalog numbers ofinstalled options entered
at factory. Change entry in Information Setup. See
Figure 4-13.

ATS Type The contactor mechanism. Contactor
mechanism is factory set and cannot be changed. This
item is displayed only for the MATS+ controller.

ATS SN (ATS Serial Number is displayed for the MATS
controller.) The transfer switch serial number. Number is
factory set and cannot be changed.
Control SN (Control Serial is displayed for the MATS
controller.) The ATS controller serial number. Number is
factory set and cannot be changed.
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Status Summary Screen Information
(continued)

Time Displays the current time at the ATS controller
location.
Date Month/Day/Year
Day of week
Time of day Hours:Minutes AM/PM
Day Occurs # The occurrence number of the day in the
current month 1-5 (displays only for the MATS controller.)
See Calendar Mode for more explanation.
Time Delays The current time delay settings in minutes
and seconds (Off to Emergency and Off to Normal time
delays are displayed only for the MATS+ controller.)

Load Shed Load shed settings for transfer to the
Normal and Emergency sources in minutes and
seconds.
Time Before The time delay for the load to be shed before
transfer to the new source.

Time After The time delay after transfer to the new source
before load return begins.

Time Sequence The elapsed time between load return
steps.
Load Returns The number of loads (up to 9) controlled in
sequence by relays 1-9.
Optional Functions Displays which features or
accessories are ENABLED or DISABLED:

In-Phase Monitor Time Delay Extended
Phase Sequence Manual Override
N/E Over/under V&F Time Delay Off (MATS+ Only)

Plant Exerciser
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4.5 Exerciser Choice Summary
Screen
See Figure 4-5 for an example of the Exerciser Choice

summary screen. Use this screen to view the plant
exerciser schedules.

Spectrum Monitor Exerciser Choice <MATS+> Designation

ESC exit. F1 Help. F8 View Schedule. F10 Main Menu.

SET?
7 DAY EXERCISER Y
14 DAY EXERCISER N
CALENDAR EXERCISER N

Figure 4-5. Exerciser Choice Summary Screen

Summary Screen Key Functions

Key Screen Function

ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen

F9 Print Displays the print menu

NOTE
If the Plant Exerciser (program shunt) is not installed in
the ATS controller, the exerciser choice screen is not
available.

Exerciser Choice Summary Screen
Information

7 DAY EXERCISER Type Y (yes) to select the 7-day
exerciser schedule for viewing. Press <F8> to view the
schedule summary. See Section 4.6 and Figure 4-6 for
information about the 7-day exerciser option.

14 DAY EXERCISER Type Y (yes) to select the 14-day
exerciser schedule for viewing. Press <F8> to view the
schedule summary. See Section 4.6 and Figure 4-7 for
information about the 14-day exerciser option.
CALENDAR EXERCISER Type Y (yes) to select the
calendar-based exerciser schedule for viewing. Press
<F8> to view the schedule summary. See Section 4.6
and Figure 4-10 for information about the calendar
exerciser option.

F10 Main Menu Returns to the Main Menu
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4.6 Seven- and Fourteen-Day Mode
Summary Screens
See Figure 4-6 for an example of the 7-Day Mode

Summary screen. See Figure 4-7 for an example of the
14-Day Mode Summary screen.

Spectrum Monitor 7 Day Mode Summary

ESC exit. F1 Help. F9 Print. F10 Main Menu.

<MATS+> Designation

EXERCISE START DAY OF WEEK | RUNTIME LOAD
EVENT TIME 18T 2ND HR:MN | TRANSFER

#1 ENABLED | 07:30AM | WED | SAT 00:45 NO

#2 ENABLED | 09:00 AM | TUE TUE 00:00 NO

#3 ENABLED | 09:00 AM | TUE TUE 00:00 NO

#4 ENABLED | 09:00 AM | TUE TUE 00:00 NO

#5 ENABLED | 09:00 AM | TUE TUE 00:00 NO

Time 8:00 AM  Day Sunday  Date 07/14/1996 Day Occurs # 2

Figure 4-6. 7-Day Mode Summary Screen

Spectrum Monitor 14 Day Mode Summary

ESC exit. F1 Help. F9 Print. F10 Main Menu.

<MATS+> Designation

EXERCISE START | DAY OF WEEK | WEEK | RUNTIME  LOAD
EVENT TIME 18T 2ND ior2 | HR:MN | TRANSFER
#1 ENABLED | 07:30AM | WED | SAT 2 00:45 NO
#2 ENABLED | 09:00 AM | TUE TUE 1 00:00 NO
#3 ENABLED | 09:00 AM | TUE TUE 1 00:00 NO
#4 ENABLED | 09:00 AM | TUE TUE 1 00:00 NO
#5 ENABLED | 09:00 AM | TUE TUE 1 00:00 NO
Time 8:00 AM Day Sunday  Date 07/14/1996 Week 2

Figure 4-7. 14-Day Mode Summary Screen

Summary Screen Key Functions

Key Screen Function

ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F9 Print Displays the print menu

F10 Main Menu Returns to the Main Menu
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7-Day and 14-Day Summary Screen
Information

EXERCISE EVENT The number of the exercise event
and whether the event is ENABLED or DISABLED.

START TIME The scheduled start time for each event’s
pair of exercise runs.

DAY OF WEEK, 1ST The day for the event’s first
exercise run.

DAY OF WEEK, 2ND The day for the event’s second
exercise run. If the days are the same, the event
contains only one exercise run.

WEEK 1 OR 2 The week of the 14-day period for the
exercise event (14-Day Mode only).

RUN TIME HR:MN The hours and minutes of the
event’s exercise runs.

LOAD TRANSFER Indicates whether the controller
exercises the generator set under a load or not. YES
indicates that the Load-No Load selector switch
(accessory 23-G if equipped) is in the LOAD position
and the controller exercises the plant under aload. NO
indicates that the switch is in the NO LOAD position or
the accessory is not installed and the controller
exercises the plant under no load. The Load-No Load
selector switch mounts inside the ATS door when
equipped. Also, a hardware jumper installed on the ATS
controller indicates the presence of this accessory.
Time and Date Information The software displays the
following information at the bottom the screen:

Time Time of day in hours:minutes AM/PM

Day Day of week

Date Month/Day/Year

Day Occurs # The occurrence number of the day in the
current month 1-5 (7-day Mode only). See Calendar Mode
for more explanation.

Week Week number 1 or 2 of schedule (14-day Mode
only)
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4.7 Calendar Mode

The Calendar Mode shows up to 5 events with 1 or 2
exercise occurrences each. The software automatically
sets the calendar date for each occurrence according to
the date setting entered in the Time of Day Setup. See
Figure 4-11. This mode uses a true calendar where the
software calculates the number of occurrences of a day
in any month. Figure 4-8 illustrates relationships of
calendar days and dates to occurrence days. The
shaded columns show occurrence numbers for days in
a typical month.

SUN MON TUE WED THU FRI SAT

VARV ARRVAR ANV ARES AN

Spectrum Monitor Calendar Mode Summary <MATS+> Designation

ESC exit. F1 Help. F9 Print. F10 Main Menu.

EXERCISE START | DAY OF OCCURRENCE # | RUNTIME  LOAD
EVENT TIME WEEK | 1ST 2ND HR:MN | TRANSFER
#1 ENABLED | 07:30 AM | SAT 2 4 00:45 NO
#2 ENABLED | 09:00 AM | TUE 1 1 00:00 NO
#3 ENABLED | 09:00 AM | TUE 1 1 00:00 NO
#4 ENABLED | 09:00 AM | TUE 1 1 00:00 NO
#5 ENABLED | 09:00 AM | TUE 1 1 00:00 NO
Time 8:00 AM Day Sunday Date 07/14/1996 Day Occurs # 2

Figure 4-10. Calendar Mode Summary Screen

61718292102112122

132 142 153 163 173 183 193

203 213 224 234 244 254 264

27 28

4 5 5 5

Figure 4-9. Typical Calendar

NOTE
Because each weekday does not always occur five
times in one month, avoid using day occurrence 5. If
you enter day occurrence 5 in a month where the
weekday does not occur five times, that exercise run will
not happen.

4.8 Calendar Mode Summary
Screen

The examples in Figure 4-10 and Figure 4-19 show
exercise event #1 enabled. Exercise runs start at
7:30 AM. The first exercise run occurs on the second
Saturday of the month; the second exercise run occurs
on the fourth Saturday. The generator set(s) runs for
45 minutes. Load does not transfer during the exercise
runs.
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Calendar Mode Summary Screen
Information

EXERCISE EVENT The number of the exercise event
and whether the event is ENABLED or DISABLED.

START TIME The scheduled start time for each event’s
pair of exercise runs.

DAY OF WEEK The day selected for each event.

OCCURRENCE #, 1ST The occurrence number 1-5 of
the day for the event’s first exercise run.

OCCURRENCE #, 2ND The occurence number 1-5 of
the day for the event’s second exercise run. If the days
are the same, the event contains only one exercise run.

RUN TIME HR:MN The hours and minutes of the
event’s exercise runs.

LOAD TRANSFER Indicates whether the controller
exercises the generator set under a load or not. YES
indicates that the Load-No Load selector switch
(accessory 23-G if equipped) is in the LOAD position
and the controller exercises the plant under aload. NO
indicates that the switch is in the NO LOAD position or
the accessory is not installed and the controller
exercises the plant under no load. The Load-No Load
selector switch mounts inside the ATS door when
equipped. Also, a hardware jumper installed on the ATS
controller indicates the presence of this accessory.
Time and Date Information The software displays the
following information at the bottom the screen:

Time Time of day in hours:minutes AM/PM

Day Day of week

Date Month/Day/Year

Day Occurs # The occurrence number 1-5 of the day in
the current month. See Calendar Mode for more
explanation.
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4.9 Time of Day Setup Screen

Use the Time of Day Setup screento set the currenttime
and date at the ATS controller location. See
Figure 4-11.

Spectrum Monitor Time of Day Setup <MATS+> Designation

ESC exit. F1 Help. F4 Update. F9 Print. F10 Main Menu.

ATS Site Present Setup
Time 03:27 PM
Date 07/16/1996

Day Tuesday
Day Occurs # 3

Figure 4-11. Time of Day Setup Screen

Setup Screen Key Functions

NOTE
If setting the time for a ATS controller located in a
different time zone, enter the time to match the time
zone at the ATS controller’s location.

Time of Day Setup Screen Information
Time The time at the ATS controller location, format
HR:MN AM or HR:MN PM
Date The date at the ATS controller location, format
MO/DY/YEAR
Day Day of the week. Automatically calculated fromthe
date.

Day Occurs # The occurrence number of the day of the
week. Automatically calculated from the date.

Key Screen Function
1 Moves the cursor up to choose
| Moves the cursor down to choose
ENTER Enters a value at the cursor position
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F4 Update Updates and stores the new settings
F9 Print Displays the print menu
F10 Main Menu  Returns to the Main Menu
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The Present column displays the present settings.
Make changes in the Setup column.

Use the arrow keys to move the cursor to the desired
location in the setup column.

Type the changes in the setup column; press <ENTER>
or the down arrow key to proceed to the next line. Press
<F4> to update the record and store the changes.
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4.10 Time Delay Setup Screen

Use the Time Delay Setup screen to set time delays in

minutes:seconds for various functions. See
Figure 4-12.
Spectrum Monitor Time Delay Setup <MATS+> Designation

ESC exit. F1 Help. F4 Update. F9 Print. F10 Main Menu.

Present Setup Limits
Engine Start 00:05 00:05 99:00
Normal to Emergency 00:05 00:05 99:00
Off to Emergency 00:05 00:05 99:00
Emergency to Normal 00:05 00:05 99:00
Off to Normal 00:05 00:05 99:00
Engine Cooldown 00:05 00:05 99:00

All times are in minutes and seconds.

Extended time delay: ENABLED

Figure 4-12. Time Delay Setup Screen

Setup Screen Key Functions

Key Screen Function
1 Moves the cursor up to choose
| Moves the cursor down to choose
ENTER Enters a value at the cursor position
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F4 Update Updates and stores the new settings
F9 Print Displays the print menu
F10 Main Menu  Returns to the Main Menu

Setup Screen Column Headings

Column Purpose
Present  Current settings
Setup Make changes here
o The software accepts inputs only within the
Limits e
range of these limits.
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Time Delay Setup Screen Information

Engine Start The time delay between the remote start
contacts closing and the engine start sequence
beginning.

Normal to Emergency The time delay before the ATS
switches from the Normal to Emergency positions.

Off to Emergency The time delay before the ATS
switches from the Off to Emergency position (displayed
only for the MATS+ controller; requires option
DD-100-B enabled to change).

Emergency to Normal The time delay before the ATS
switches from the Emergency to Normal positions.

Off to Normal The time delay before the ATS switches
from the Off to Normal position (displayed only for the
MATS+ controller; requires option DD-100-B enabled to
change).

Engine Cooldown Thetime delay between the remote
start contacts opening and the engine stop sequence.

Extended Time Delay Displayed as ENABLED or
DISABLED. Enable extended time delays (option
DD-100-B) with a main controller board shunt. This
feature cannot be changed by using the software. If
enabled, time delays can be extended to 99 minutes.

The Present column displays the existing settings.
Make changes in the Setup column.

Use the arrow keys to move the cursor to the desired
location in the setup column.

Type the changes; press <ENTER> or the down arrow
key to proceed to the next line. Press <F4> to update
the record and store the changes.
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4.11 Information Setup Screen

See Figure 4-13 for an example of the Information
Setup screen.

ATS information is normally entered only at system
installation and/or initial startup.

Spectrum Monitor Information Setup <MATS+> Designation

ESC exit. F1 Help. F4 Update. F9 Print. F10 Main Menu.

Present Setup

Normal  Emergency
System Voltage 120 VAC 120 VAC
System Frequency 60.0 Hz 60.0 Hz
Single/Three Ph 1 3
Amperage 30 Poles 2
Designation Designation

Amperage 30 Poles 2
Designation Designation

Load LITTLE ONE Load LITTLE ONE
Branch  AIR MAKEUP Branch AIR MAKEUP
Location ~ SOUTH 1 Location ~ SOUTH 1
Options ~ 06B, 08C, 08D, 05K Options 06B, 08C, 08D, 05K
Limits
ATS Type Zenith With Off Position System Voltage 105 TO 600 VAC
ATS SN K000000  Control SN C000000 System Frequency 48.0 TO 62.0 HZ

Address 1

Figure 4-13. Information Setup Summary Screen

Setup Screen Key Functions

Key Screen Function
1 Moves the cursor up to choose
| Moves the cursor down to choose
ENTER Enters a value at the cursor position
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F4 Update Updates and stores the new settings
F9 Print Displays the print menu
F10 Main Menu  Returns to the Main Menu

Designation An optional unique name describing
location, function, etc.

Load An optional description of the connected load,
such as total building, HYAC motors, etc.

Branch An optional description of the switch location by
distribution branch, such as service entrance, branch
circuit breaker number, etc.

Location An optional description of the physical
location of the transfer switch.

Options The catalog numbers of enabled and installed
accessories for reference when servicing the transfer
switch. Each entry is limited to three characters. You
can enter up to 12 accessories although more than 12
accessories may be installed. Check the transfer
switch’s nameplate to see a list of all installed
accessories.

ATS Type The type of contactor mechanism. The
contactor mechanism is factory set and cannot be
changed. This item is displayed only for the MATS+
controller.

ATS SN (ATS Serial Number is displayed for the MATS
controller.) The transfer switch serial number. Number
is factory set and cannot be changed.

Control SN (Control Serial is displayed for the MATS
controller.) The ATS controller serial number. Number
is factory set and cannot be changed.

Address Displays the current address of the unit on an
RS-485 network. Set at the local display and keypad.
Limits Limits shown for System Voltage and System
Frequency are factory set and cannot be changed.

Information Setup Screen Information

System Voltage, System Frequency, and
Single/Three Ph[ase] Displays these settings in the
Present column as shown on the ATS nameplate.
These settings are factory set.

Amperage The ATS contactor current rating in amps.
Poles The number of poles on the ATS contactor.
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The Present column displays the existing settings.
Make changes in the Setup column.

Use the arrow keys to move the cursor to the desired
location in the setup column.

Type the changes; press <ENTER> or the down arrow
key to proceed to the next line. Press <F4> to update
the record and store the changes.
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4.12 Trip Point Setup Screen

The Trip Point Setup screen shows normal and
emergency source pickup and dropout points as
percentages of system voltage and frequency. See
Figure 4-14 for an example of the Trip Point Setup
screen.

Spectrum Monitor Trip Point Setup <MATS+> Designation

ESC exit. F1 Help. F4 Update. F9 Print. F10 Main Menu.

Present Setup Limits

Trip Points Normal Emergency Normal Emergency

Overvolt Dropout 115 % 115 % 115 % 115 % 105 - 135%
Qvervolt Pickup 110 % 10 % 10% 110 % 100 - 130 %
Undervolt Pickup 90 % 90 % 90 % 90 % 75-100 %
Undervolt Dropout 85 % 85 % 85 % 85 % 70-95%
Qverfreq Dropout 115 % 115 % 1M15% 115 % 105-135%
OQverfreq Pickup 110 % 110 % 10% 110 % 100 - 130 %
Underfreq Pickup 90 % 90 % 90 % 90 % 85-100 %
Underfreq Dropout 85 % 85 % 85 % 85 % 80-95%

Normal and Emergency Over/Under Voltage and Frequency: ENABLED

NOTE: 2% minimum differential between pickup and dropout must be maintained.

Figure 4-14. Trip Point Setup Screen

Setup Screen Key Functions

NOTE
Normal and Emergency Over/Under Voltage and
Frequency (option 34-J) at the second-from-bottom line
of the screen must show ENABLED in order to enter
optional settings.

NOTE
Set Over trip points at least 2% higher than Under trip
points.

Trip Point Setup Screen Information
Setting up trip points:

1. Use the arrow keys to position the cursor in the
Normal or Emergency columns and type the
settings. Use an arrow key or press <ENTER> to
move the cursor to another trip point setting.

2. If you press <F4> and the screen displays the
message Setup Value Out of Limit, a
setting is out of the limit range. The cursor box
highlights the out-of-limit setting. Press any key
and enter a new setting that is within the limitrange.
Press <F4> again to store the new settings in the
ATS controller. Press <ESC> to return to the ATS
Data Menu.

Key Screen Function
1 Moves the cursor up to choose
| Moves the cursor down to choose
ENTER Enters a value at the cursor position
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F4 Update Updates and stores the new settings
F9 Print Displays the print menu
F10 Main Menu  Returns to the Main Menu

Setup Screen Column Headings

Column Purpose
Present  Current settings
Setup Make changes here
Limi The software accepts inputs only within the

imits s

range of these limits.
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The Present column displays current information. Make
changes in the Setup column. The Limits column
displays the possible percentage ranges for each
setting.
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4.13 Load Shed Setup Screen

The Load Shed Setup screen shows load-shed time
settings in minutes and seconds. See Figure 4-15 for
an example of the Load-Shed Setup screen.

Spectrum Monitor Load Shed Setup <MATS+> Designation

ESC exit. F1 Help. F4 Update. F9 Print. F10 Main Menu.

NOTE
The number of load returns after transfer to emergency
may be smaller than for transfer to normal. In this case,
the system has been designed to allow certain
nonessential loads shed when the transfer switch is in
the emergency position.

Present Setup Limits
Trip Points Normal Emergency Normal Emergency
Time Before 00:00 00:00 00:00 00:00 99:00
Time After 00:00 00:00 00:00 00:00 99:00
Time Sequence 00:00 00:00 00:00 00:00 99:00
Load Returns 9 9 9 9 1 - 9 Loads

All times are in minutes and seconds.

Extended time delay: ENABLED

Figure 4-15. Load Shed Setup Screen

Setup Screen Key Functions

Key Screen Function
1 Moves the cursor up to choose
| Moves the cursor down to choose
ENTER Enters a value at the cursor position
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F4 Update Updates and stores the new settings
F9 Print Displays the print menu
F10 Main Menu  Returns to the Main Menu

Setup Screen Column Headings

Column Purpose
Present  Current settings
Setup Make changes here

o The software accepts inputs only within the
Limits e

range of these limits.
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Load Shed Setup Screen Information
Time Before The time before transfer to the related
source that the load is signaled to shed.

Time After The time after transfer to the related source
before load return begins.

Time Sequence The elapsed time between load return
steps.

Load Returns The number of steps (blocks) of load
that will return after transfer to the related source.
Load-Return signals are provided by up to 9 relays on

the transfer switch logic panel. Relays provide signals
to separate load control relays and circuit breakers.

The Present column displays current information. Make
changes in the Setup column. The Limits column
displays the maximum allowable time for each setting.
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4.14 Plant Exerciser Choice Setup
Screen

See Figure 4-16 for an example of the Plant Exerciser
Choice Setup screen.

Plant exerciser schedule choices are 7-day, 14-day, and
Calendar (5-week) modes.

Spectrum Monitor Plant Exerciser Choice Setup <MATS+> Designation

ESC exit. F1 Help. F4 Update. F8 View Schedule. F10 Main Menu.

PRESENT  SETUP
7 DAY EXERCISER Y

14 DAY EXERCISER N -

CALENDAR EXERCISER N -

STOP PLANT EXERCISER -
TO SELECT AN EXERCISER, OR TO STOP PLANT EXERCISER
USE ARROW KEY TO POSITION CURSOR AND TYPE “Y”.
THEN PRESS “F4” KEY.

CAUTION!! CHANGING EXERCISER WILL CAUSE ALL EXERCISER
INFORMATION TO BE LOST.

Figure 4-16. Plant Exerciser Choice Setup Screen

Setup Screen Key Functions

Key Screen Function
1 Moves the cursor up to choose
| Moves the cursor down to choose
ENTER Enters a value at the cursor position
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F4 Update Updates and stores the new settings
F9 Print Displays the print menu
F10 Main Menu  Returns to the Main Menu
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Plant Exerciser Setup Screen Information
To select an exerciser schedule:

Use the up or down arrow key to move the cursor to the
selected line in the Setup column. Type Y to make a
selection. Press <F4> to store your choice. When you
change a choice, former settings are lost. Press <F8>
to view your choice and make settings.

To stop the exerciser during an exercise run:

Use the down arrow key to move the cursor to STOP
PLANT EXERCISER. TypeY and press <F4>. Thiswill
zero out the exercise timer.
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4.15 Seven-Day Mode Setup Screen

See Figure 4-17 for an example of the 7-Day Mode
Setup screen. Use the following procedures to enable
or disable exercise events for a 1-week period.

Spectrum Monitor 7 Day Mode Setup <MATS+> Designation

ESC exit. F1 Help. F4 Update. F9 Print. F10 Main Menu.

EXERCISE START DAY OF WEEK RUNTIME LOAD
EVENT TIME 18T 2ND HR:MN TRANSFER

#1 ENABLED  07:30 AM WED  SAT 00:45 NO
E 07:30AM  WED  SAT 00:45

#2 ENABLED  09:00 AM TUE TUE 00:00 NO
D 09:00AM  TUE TUE 00:00

#3 ENABLED  09:00 AM TUE TUE 00:00 NO
D 09:00AM  TUE TUE 00:00

#4 ENABLED  09:00 AM TUE TUE 00:00 NO
D 09:00AM  TUE TUE 00:00

#5 ENABLED  09:00 AM TUE TUE 00:00 NO
D 09:00AM  TUE TUE 00:00
LIMITS: TUE - SUN 0-4:00

USE ARROW KEYS TO POSITION CURSOR UNDER DESIRED
EVENT AND ENTER NEW VALUES, F4 WILL UPDATE ATS

Time 8:00 AM  Day Wednesday Date 07/17/1996 Day Occurs # 3

Figure 4-17. 7-Day Mode Setup Screen

Setup Screen Key Functions

NOTE
If you are setting the start time for a remote transfer
switch located in a different time zone, enter the time to
match the time zone at the transfer switch’s location.

Key Screen Function
1 Moves the cursor up to choose
| Moves the cursor down to choose
ENTER Enters a value at the cursor position
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F4 Update Updates and stores the new settings
F9 Print Displays the print menu
F10 Main Menu  Returns to the Main Menu
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7-Day Mode Setup Screen Information

See Section 4.6 for details on 7-day mode exerciser
event fields.
To set up 7-day mode exerciser events:
1. Position the cursor box on the enable/disable
exercise event choice. Type E and press

<ENTER> to enable the event. Type D and press
<ENTER> to disable the event.

2. Type the desired time of day for a start time and
press <ENTER>.

3. Type aday for the first exercise run of the eventand
press <ENTER>.

4. Type aday for the second exercise run of the event
and press <ENTER>.

NOTE: To choose only one exercise run per event,
make the DAY entries the same.

5. Type hours:minutes for the event exercise run
times and press <ENTER>.

The cursor moves to the enable/disable choice for the
next event. Repeat the above steps to set up as many
exercise runs as necessary. The maximum number of
exercise runs is 10, 5 events of 2 exercise runs each
week. Press <F4> to store your new settings inthe ATS
controller.

LOAD TRANSFER If Yes, the Load/No-Load Exercise
switch is in the LOAD position. If No, the switchis in the
NO LOAD position. The Load/No-Load selector switch
(accessory 23-G, if equipped) is mounted inside the
transfer switch cabinet door. Also, a hard-wired jumper
installed on the ATS controller indicates load transfer.
This setting can be changed only at the transfer switch.

ATS Controller Data Menu 43



4.16 Fourteen-Day Mode Setup
Screen
See Figure 4-18 for an example of the 14-Day Mode

Setup screen. Use the following procedures to enable
or disable exercise events for a 2-week period.

Spectrum Monitor 14 Day Mode Setup <MATS+> Designation

ESC exit. F1 Help. F4 Update. F9 Print. F10 Main Menu.

EXERCISE ~ START DAY OF WEEK RUNTIME  LOAD
EVENT TIME 18T 2ND 10R2 HR:MN  TRANSFER
#1 ENABLED  07.30AM  WED  SAT 2 00:45 NO
E 07:30AM  WED  SAT 2 00:45
#2 ENABLED  09:.00AM  TUE TUE 1 00:00 NO
D 09:00AM  TUE TUE 1 00:00
#3ENABLED  09:00AM  TUE TUE 1 00:00 NO
D 09:00AM  TUE TUE 1 00:00
#4 ENABLED  09:.00AM  TUE TUE 1 00:00 NO
D 09:00AM  TUE TUE 1 00:00
#5ENABLED  09:.00AM  TUE TUE 1 00:00 NO
D 09:00AM  TUE TUE 1 00:00
LIMITS: TUE - SUN -2 0-4:.00

USE ARROW KEYS TO POSITION CURSOR UNDER DESIRED
EVENT AND ENTER NEW VALUES, F4 WILL UPDATE ATS

Time 8:00 AM Day Sunday Date 07/17/1996 Week 2

Figure 4-18. 14-Day Mode Setup Screen

Setup Screen Key Functions

NOTE
If you are setting the start time for a remote transfer
switch located in a different time zone, enter the time to
match the time zone at the transfer switch’s location.

Key Screen Function
1 Moves the cursor up to choose
| Moves the cursor down to choose
ENTER Enters a value at the cursor position
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F4 Update Updates and stores the new settings
F9 Print Displays the print menu
F10 Main Menu  Returns to the Main Menu
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14-Day Mode Setup Screen Information

See Section 4.6 for details on 14-day mode exerciser
event fields.
To change 14-day mode exerciser events:
1. Position the cursor box on the enable/disable
exercise event choice. Type E and press

<ENTER> to enable the event. Type D and press
<ENTER> to disable the event.

2. Type the desired time of day for a start time and
press <ENTER>.

3. Type aday for the first exercise run of the eventand
press <ENTER>.

4. Type aday for the second exercise run of the event
and press <ENTER>

NOTE: To choose only one exercise run per event,
make the DAY entries the same.

5. Type a week (1 or 2) of the 14-day period for the
event and press <ENTER>.

6. Type hours:minutes for the event exercise run
times and press <ENTER>.

The cursor moves to the enable/disable choice for the
next event. Repeat the above steps to set up as many
exercise runs as necessary. The maximum number of
runsis 10, 5 events of 2 exercise runs per event for each
14-day period. Press <F4> to store your new settingsin
the ATS controller.

LOAD TRANSFER If Yes, the Load/No-Load Exercise
switch is in the LOAD position. If No, the switchis inthe
NO LOAD position. The Load/No-Load selector switch
(accessory 23-G, if equipped) is mounted inside the
cabinet door. Also, a hard-wired jumper installed on the
ATS controller indicates load transfer. This setting can
be changed only at the transfer switch.
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4.17 Calendar Mode Setup Screen

See Figure 4-19 for an example of the Calendar Mode
Setup screen. Use the following procedures to enable
or disable exercise events over a 2-week period.

Spectrum Monitor Calendar Mode Setup <MATS+> Designation

ESC exit. F1 Help. F4 Update. F9 Print. F10 Main Menu.

EXERCISE ~ START DAY OF OCCURRENCE# RUNTIME  LOAD
EVENT TIME WEEK 18T 2ND HR:IMN  TRANSFER

#1 ENABLED  07:30AM  SAT 2 4 00:45 NO
E 07:30 AM  SAT 2 4 00:45

#2 ENABLED  09:00AM  TUE 1 1 00:00 NO
D 09:00 AM  TUE 1 1 00:00

#3ENABLED  09:00AM  TUE 1 1 00:00 NO
D 09:00 AM  TUE 1 1 00:00

#4ENABLED  09:.00AM  TUE 1 1 00:00 NO
D 09:00 AM  TUE 1 1 00:00

#5ENABLED  09:.00AM  TUE 1 1 00:00 NO
D 09:00AM  TUE 1 1 00:00
LIMITS: TUE-SUN 1-5 1-5  0-4:00

USE ARROW KEYS TO POSITION CURSOR UNDER DESIRED
EVENT AND ENTER NEW VALUES, F4 WILL UPDATE ATS

Time 8:00 AM  Day Wednesday Date 07/17/1996 Day Occurs # 3

Figure 4-19. Calendar Mode Setup Screen

Setup Screen Key Functions

NOTE
If you are setting the start time for a remote transfer
switch located in a different time zone, enter the time to
match the time zone at the transfer switch’s location.

Key Screen Function
1 Moves the cursor up to choose
| Moves the cursor down to choose
ENTER Enters a value at the cursor position
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F4 Update Updates and stores the new settings
F9 Print Displays the print menu
F10 Main Menu  Returns to the Main Menu
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Calendar Mode Setup Screen Information

See Section 4.8 for details on calendar mode exerciser
event fields.

To change calendar mode exerciser events:

1. Position the cursor box on the enable/disable
exercise event choice. Type E and press
<ENTER> to enable the event. Type D and press
<ENTER> to disable the event.

2. Type the desired time of day for a start time and
press <ENTER>.

3. Type a day for the event’s exercise runs and press
<ENTER>.

4. Type a number (1-5) for a day occurrence on which
the event’s first (#1) exercise run is to take place
and press <ENTER>.

5. Type anumber (1-5) for a day occurrence on which
the event's second (#2) exercise run is to take
place and press <ENTER>.

NOTE: Enter a zero to prevent the respective exercise
run (#1 and/or #2) from taking place.

6. Type hours:minutes for the event exercise run
times and press <ENTER>.

The cursor moves to the enable/disable choice for the
next event. Repeat the above steps to set up as many
exercise runs as necessary. The maximum number of
runsis 10, 5 events of 2 exercise runs per event for each
month. Press <F4> to store your new settings in the
ATS controller.

LOAD TRANSFER If Yes, the Load/No-Load Exercise
switch is inthe LOAD position. If No, the switchis in the
NO LOAD position. The Load/No-Load selector
(accessory 23-G, if equipped) switch is mounted inside
the cabinet door. Also, a hard-wired jumper installed on
the ATS controller indicates load transfer. This setting
can be changed only at the transfer switch.
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4.18 Engine Start Setup Screen

This screen allows you to start and run the generator set
for a specified period of time. To see this screen, the
Plant Exerciser option must be enabled. See
Figure 4-16. This could be used to verify that the
emergency source is running and available for an
anticipated outage or to manually start the generator set
for an interruptible-rate situation. See Figure 4-20 for
an example of the Engine Start Setup screen.

Spectrum Monitor Engine Start Setup <MATS+> Designation

ESC exit. F1 Help. F4 Update. F8 Exer Stop.F9 Print. F10 Main Menu.

Present Setup Limits
Run Time 00:00 00:00 0-72:00 HR:MN
Load Transfer No N
BP TDNE? No N
BP TDNE? No N

Plant Exerciser: ENABLED
Plant Exerciser Load/No Load: NO LOAD
Generator Running: NO

Figure 4-20. Engine Start Setup Screen

Setup Screen Key Functions

Key Screen Function
1 Moves the cursor up to choose
| Moves the cursor down to choose
ENTER Enters a value at the cursor position
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F4 Update Updates and stores the new settings
F8 Exer Stop Stops the exerciser mode
F9 Print Displays the print menu
F10 Main Menu  Returns to the Main Menu

Setup Screen Column Headings

Column Purpose

Present  Current settings

Setup Make changes here

Limits The software accepts inputs only within the

range of these limits.
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NOTE
The screen will not show the source of the engine-start
signal, i.e., plant exerciser, a remote-start contact, or
engine start signal from the local panel or remote
computer.

NOTE
This screen allows the operator of the software to start
and run a generator set that is not within sight of the
operator. Use extreme care when using this feature to
prevent accidental starting of the generator set.

NOTE
The run time returns to 00:00 and Load Transfer, BP
TDNE, and BP TDEN return to No after the generator
run time completes.

Engine Start Setup Screen Information

To set the run time and start the generator set, proceed
as follows:

1. Position the cursor in the Run-Time row, Setup
column.

2. Type the time in hours:minutes. The
engine-generator set stops after the set time and
all other timers have expired. Maximum time is
72:00 (72 hours).

3. Use the Load Transfer option to override any
Load/No-Load setting made at the transfer switch.
TypeY for yes if you want to transfer to emergency.
Type N (no) only if you want to make the
emergency source available or to test run the
engine.

4. Atthe BP TDNE? choice, type Y (yes) if you want to
bypass the normal-to-emergency time delay.

5. Atthe BP TDEN? choice, type Y (yes) if you wantto
bypass the emergency-to-normal time delay.

6. After making your choices, press <F4>; confirm
with Y and press <ENTER> to start the generator
set.

NOTE: If you want to stop the exerciser before the run
time completes, press <F8>. The transfer
switch retransfers to normal (if in emergency)
and the generator set runs through the engine
cooldown cycle. The run-time setting return to
00:00. To stop the generator set from the Plant
Exerciser Choice Setup menu, use the down
arrow key to move to the STOP PLANT
EXERCISER choice, type Y, and press <F4>.
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Engine Start Setup Screen Information
(continued)
Plant Exerciser Shows ENABLED ifthe enabling shuntis
installed or Disabled if the enabling shunt is not installed.

Plant Exerciser Load/No Load The position of the
load/no-load exerciser switch, LOAD or NO LOAD
(accessory 23-G, located on inside of cabinet door if
equipped).

Generator Running YES if generator set is running, NO if
generator set is not running.
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Notes
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Section 5. Power Monitor Data Menu

5.1 Data Menu Screen Selections

The software displays the power monitor Data Menu
screen when it establishes communications with the
Digital power monitor. See Figure 5-1.

Spectrum Monitor Data Menu <PWRMON> Designation

1 and | to choose. ENTER selects ESC Previous Menu.  F1Help  F10 Main Menu.

Data Menu i

Status Summary
Setting Summary
Operational Summary
Time of Day Setup
Time Delay Setup
Information Setup
Test Mode Setup

Programming Mode: REMOTE

Figure 5-1. Digital Power Monitor Data Menu
Screen

The Data Menu screen and other screens described in
this section have <PWRMON> Designation in the upper
right-hand corner. Enter the designation, an optional
descriptive name for the device, on the Information
Setup screen. See Section 5.8. These identifiers allow
you to know the type of device and its designation the
screen displays.

Figure 5-2 lists the selections that appear on the Data
Menu screen. The software also displays the current
programming mode at the bottom of the screen. If the
power monitor is not in the REMOTE programming
mode (OFF or LOCAL), the Data Menu screen displays
the summary screen selections only.
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Menu ltem Figure Section
Status Summary Figure 5-3 53
Setting Summary Figure 5-4 54
Operational Summary Figure 5-5 55
Time of Day Setup Figure 5-6 56
Time Delay Setup Figure 5-7 57
Information Setup Figure 5-8 5.8
Test Mode Setup Figure 5-9 59

Figure 5-2. Digital Power Monitor Data Menu
Screen Selections

Summary screens display power monitor conditions
and settings but do not allow programming. Use the
setup screens to program the power monitor’s various
settings and functions.

Although you enter data in the setup screens, all data is
transferred to the power monitor upon update and
stored in its memory. See the power monitor operation
and installation manual for the factory default values.

Use the up arrow 1 or down arrow | key to highlight the
desired menu selection and press <ENTER> to proceed
to that screen. Press the <ESC> key to return to the
Data Menu screen.

Regular updates occur to screen information. The COM
port baud rate determines the update frequency.

5.2 Printing Options

Press <F9> in the summary and setting screens to get
the print options menu. Use the up and down arrow keys
to select from the following options.

® Print to Printer prints a hard-copy report of the
current screen to the printer the system designates
as LPT1.

® Save Reportto a File asks to provide a name for a
file and saves the current screen report to the file.

® Review Report provides a print preview of a
screen report.
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5.3 Status Summary Screen

The Status Summary screen displays a summary of the
current status of the power monitor. See Figure 5-3.

Spectrum Monitor Status Summary <PWRMON> Designation

ESC exit. F1 Help. F9 Print. F10 Main Menu.

Contactor Position NORMAL Friday 09/26/1997 01:28 PM
Voltage/Frequency System Alert System Ready

L1-L2 Voltage 480 VAC Program Mode Remote

L2-L3 Voltage 480 VAC

L3-L1 Voltage 480 VAC L1 Current 300 Amp

L1-LO Voltage 277 VAC L2 Current 300 Amp

L2-LO Voltage 277 VAC L3 Current 300 Amp

L3-LO Voltage 277 VAC Power Factor 0.8

Frequency 60.0 Hz Total KWATTS 333 KW

Total kVARS 250 KVARS

Analog Input 1 20.0

Analog Input 2 50.0

Power Supply Voltage 13.2 VDC

Figure 5-3. Status Summary Screen

Summary Screen Key Functions

Key Screen Function

ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F9 Print Displays the print menu

F10 Main Menu Returns to the Main Menu
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Status Summary Screen Information

Contactor Position Displays the Automatic Transfer
Switch (ATS) contactor position as NORMAL, OFF,
EMERGENCY, or UNDEFINED.
AC Voltage and Frequency Displays voltage and
frequency readings for AC power.
Voltage The voltage on each AC phase L1-L2, L2-L3,
L3-L1, L1-LO, L2-LO, and L3-LO
Frequency The system frequency in hertz (Hz.)

Analog DC Inputs
auxiliary inputs.
Analog Input 1 Analog auxiliary input 1

Displays readings for analog

Analog Input 2 Analog auxiliary input 2

Power Supply Voltage The power monitor’s internal DC

power supply voltage
Time Displays the current time at the power monitor
location.

Day of week

Date Month/Day/Year

Time of day Hours:Minutes AM/PM
System Alert Shows the operating mode of the unit.
See the unit operation and installation manual for more
information.

Auxiliary 1-6 An system warning condition exists caused
by auxiliary warning contact input 1-6.

Test Mode Active The ATS test mode is active.

Internal Error The power monitor has detected an internal
memory error.

System Ready No system warning condition is present.
Power Down Error The power monitor has detected a
power down error.
Program Mode Shows the current programming
mode: Local, Off, or Remote.
AC Current and Power Displays current and power
readings for AC power.

L1, L2, L3 Current The amperage readings for Linet,
Line 2, and Line 3

Power Factor The power factor
Total KWATTS The total load in kilowatts

Total kVARS The  total
volts-amperes-reactive

thousands of
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5.4 Setting Summary Screen

The Setting Summary screen displays a summary of the
current settings for the power monitor. See Figure 5-4.

Spectrum Monitor

Setting Summary <PWRMON> Designation

ESC exit.

F1 Help. F9 Print. F10 Main Menu.

Spec. No. 012345

System Information Friday 09/26/1997 01:28 PM
System Voltage 480 VAC Time Delays MIN:SEC
System Frequency 60 Hz Auxiliary 1 00:00
Single/Three Phase 3 WYE Auxiliary 2 00:00
ATS Rating 1000 Auxiliary 3 00:00
Network Address 4 Auxiliary 4 00:00
Load Heater Auxiliary 5 00:00
Location Room 201 Auxiliary 6 00:00
Model No. ZCD-566341-800 Serial Number 002222

Control Serial Number C000000

Figure 5-4. Setting Summary Screen

Summary Screen Key Functions

Key Screen

ESC  Exit
F1 Help
F9 Print

F10 Main Menu

Function

Returns to the previous menu or screen
Displays the help screen

Displays the print menu

Returns to the Main Menu

MP-5823 3/98

Setting Summary Screen Information

System Information Displays information about the
monitored system.
System Voltage Displays the monitored system voltage
setting. Normally set at installation.
System Frequency Displays the monitored system
frequency setting. Normally set at installation.
Single/Three Phase Displays electrical system type,
SINGLE for single-phase, 3 WYE for three-phase wye, or
3 DELTA forthree-phase delta. Normally set atinstallation.

ATS Rating Displays the load or ATS contactor current
rating. Normally set at installation.

Network Address Displays the current address of the unit
on an RS-485 network. Set at the local display and
keypad.

Load The optional description for the connected load,
programmable on the Information Setup screen.

Location An optional description for the location of the
load or ATS, programmable on the Information Setup
screen.

Time Displays the current time at the power monitor
location.

Day of week

Date Month/Day/Year

Time of day Hours:Minutes AM/PM

Time Delays
Auxiliary 1,2, 3,4,5,6 Thetime delay inminutes:seconds
after a customer-provided auxiliary warning contact 1-6
closes before the power monitor indicates a system
warning condition and turns on the corresponding relay
driver output (RDO). Change the time delays using the
Time Delays Setup screen.

ATS Information Displays information intended for use
with a connected Automatic Transfer Switch (ATS)
(your application may differ).
Model No. Displays the load or ATS model number.
Spec. No. Displays the load or ATS specification number.
Serial Number Displays the load or ATS serial number.

Control Number Displays the load or ATS controller serial
number.
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5.5 Operational Summary Screen

The Operational Summary screen displays a summary
of the system and ATS contactor history.
See Figure 5-5.

Spectrum Monitor Operational Summary <PWRMON> Designation

ESC exit. F1 Help. F9 Print. F10 Main Menu.

Friday 09/26/1997 01:28 PM

System History Date Operational Status ~ Hours
1 Test Mode Active 09/22/1997 | Time in Normal 610.3
2 Auxiliary 2 09/22/1997 | Time in Off 2139
3 Auxiliary 1 09/22/1997 | Time in Emergency 0.0
4 Test Mode Active 09/16/1997

Figure 5-5. Operational Summary Screen

Summary Screen Key Functions

Operational Summary Screen Information

Time Displays the current time at the power monitor
location.

Day of week

Date Month/Day/Year

Time of day Hours:Minutes AM/PM

System History Displays a history of the four most
recent auxiliary warnings or ATS tests and the date on
which they occurred.

Operational Status Displays time in hours in each
contactor position (Normal, Off, and Emergency)
according to contact information from the ATS.

Key Screen Function

ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F9 Print Displays the print menu

F10 Main Menu Returns to the Main Menu

52 Power Monitor Data Menu
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5.6 Time of Day Setup Screen

Use the Time of Day Setup screento set the currenttime
and date at the power monitor location. See Figure 5-6.

Spectrum Monitor Time of Day Setup ~ <PWRMON> Designation

ESC exit. F1 Help. F4 Update. F9 Print. F10 Main Menu.

Device Site Present Setup
Time 11:50 AM
Date 09/26/1997

Friday

Figure 5-6. Time of Day Setup Screen

Setup Screen Key Functions

Key Screen Function
1 Moves the cursor up to choose
| Moves the cursor down to choose
ENTER Enters a value at the cursor position
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F4 Update Updates and stores the new settings
F9 Print Displays the print menu
F10 Main Menu  Returns to the Main Menu

MP-5823 3/98

NOTE
If setting the time for a power monitor located in a
different time zone, enter the time to match the time
zone at the power monitor’s location.

Time of Day Setup Screen Information

Time The time at the power monitor’s location, format
HR:MN AM or HR:MN PM

Date The date at the power monitor’s location, format
MO/DY/YEAR. The software automatically calculates
the day of the week from the date upon update and
displays it under the present date.

The Present column displays the existing settings.
Make changes in the Setup column.

Use the arrow keys to move the cursor to the desired
location in the setup column.

Type the changes; press <ENTER> or the down arrow
key to proceed to the next line. Press <F4> to update
the record and store the changes.
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5.7 Time Delay Setup Screen

Use the Time Delay Setup screen to change the names
and time delays in minutes:seconds for auxiliary
warnings 1-6. See Figure 5-7.

Spectrum Monitor Time Delay Setup <PWRMON> Designation

ESC exit. F1 Help. F4 Update. F9 Print. F10 Main Menu.

Present Setup Present Setup  Limits
Auxiliary 1 00:00 00:00 00:00-01:00
Auxiliary 2 00:00 00:00 00:00-01:00
Auxiliary 3 00:00 00:00 00:00-01:00
Auxiliary 4 00:00 00:00 00:00-01:00
Auxiliary 5 00:00 00:00 00:00-01:00
Aucxiliary 6 00:00 00:00 00:00-01:00

All times are in minutes and seconds.

Figure 5-7. Time Delay Setup Screen

Setup Screen Key Functions

Key Screen Function

1 Moves the cursor up to choose

| Moves the cursor down to choose
ENTER Enters a value at the cursor position
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F4 Update Updates and stores the new settings
F9 Print Displays the print menu
F10 Main Menu  Returns to the Main Menu

Setup Screen Column Headings

Column Purpose
Present  Current settings
Setup Make changes here
Limits The software accepts inputs only within the

range of these limits.

54 Power Monitor Data Menu

Time Delay Setup Screen Information

Auxiliary 1-6, Names Displays the names of auxiliary
warning contact inputs 1-6 in the left part of the screen
under the Present column. Default names shown.
Change the names in the Setup column, 20 character
limit.

Auxiliary 1-6, Time Delays Displays the time delays in
minutes:seconds for auxiliary warning inputs 1-6 on the
right part of the screen under the Present column.
Change the time delays in the Setup column. The Limit
column displays the limits for the time delays.

The Present column displays the existing settings.
Make changes in the Setup column.

Use the arrow keys to move the cursor to the desired
location in the setup column.

Type the changes; press <ENTER> or the down arrow
key to proceed to the next line. Press <F4> to update
the record and store the changes.
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5.8 Information Setup Screen

Use the Information Setup screen to enter power
monitor information. This information is normally
entered only at time of system installation and/or initial
startup. See Figure 5-8.

Spectrum Monitor Information Setup <PWRMON> Designation

ESC exit. F1 Help. F4 Update. F9 Print. F10 Main Menu.

Present Setup
System Voltage 480 VAC

System Frequency 60 Hz

Single/Three Phase 3 WYE

ATS Rating 1000

Designation Designation
Load Heater Load

Location Room 201 Location
Model No. ZCD-566341-800

Spec No. 012345

Serial No. 000022
Control Serial Number C000000
Network Address 4
Analog Input 1 Analog Auxiliary 1 | Analog Input 1

Analog Input 2 Analog Auxiliary 2 | Analog Input 2

Figure 5-8. Information Setup Screen

Setup Screen Key Functions

Key Screen Function
1 Moves the cursor up to choose
| Moves the cursor down to choose
ENTER Enters a value at the cursor position
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F4 Update Updates and stores the new settings
F9 Print Displays the print menu
F10 Main Menu  Returns to the Main Menu

MP-5823 3/98

Information Setup Screen Information

System Voltage The monitored system voltage.
Normally set at installation.

System Frequency The monitored system frequency.
Normally set at installation.

Single/Three Phase Electrical system type, SINGLE
for single-phase, 3 WYE for three-phase wye, or 3
DELTA for three-phase delta. Normally set at
installation.

ATS Rating The ATS contactor current rating.
Normally set at installation.

Designation Describes the location, function, etc. of
the load, ATS, or power monitor. Enter up to 9
characters. The designation appears on all setup and
summary screens for the power monitor in the upper
right corner of the screen.

Load A description of the connected load (total
building, HVAC, motors, etc), optional. Enter up to 20
characters.

Location A description of the power monitor’s location,
optional. Enter up to 20 characters.

Model No. The model number of the ATS, 26
characters. Normally set at installation.

Spec No. The specification number for the ATS,
16 characters. Normally set at installation.

Serial No. The serial number for the ATS. Normally set
at installation.

Control Serial Number The ATS controller serial
number. Normally set at installation.

Network Address Displays the current address of the
unit on an RS-485 network. Set at the local display and
keypad.

Analog Input 1-2 The current name for the each
analog auxiliary input. You can rename each analog
auxiliary input with a description of up to 20 characters.
The new name appears in menus and screens instead
of the default Analog Auxiliary 1 or Analog Auxiliary 2.

The Present column displays the existing settings.
Make changes in the Setup column.

Use the arrow keys to move the cursor to the desired
location in the setup column.

Type the changes; press <ENTER> or the down arrow
key to proceed to the next line. Press <F4> to update
the record and store the changes.
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5.9 Test Mode Setup Screen

Use the Test Mode Setup screento perform an ATS test
for a specified time period. See Figure 5-9.

Spectrum Monitor Test Mode Setup <PWRMON> Designation

ESC exit. F1Help. F4Update. F8STOP Test Mode. F9 Print. F10 Main Menu.

Present Setup Limits

Timed Test NO
Run Time 00:00 00:00  0-72:00 HR:MN
Manual Test NO

Contactor Position NORMAL

Figure 5-9. Test Mode Setup Screen

Setup Screen Key Functions

Key Screen Function
1 Moves the cursor up to choose
| Moves the cursor down to choose
ENTER Enters a value at the cursor position
ESC Exit Returns to the previous menu or screen
F1 Help Displays the help screen
F4 Update Updates and stores the new settings
F8 nsnzgg Test Deactivates the ATS test mode.
F9 Print Displays the print menu
F10 Main Menu  Returns to the Main Menu

Setup Screen Column Headings

Column Purpose
Present  Current settings
Setup Make changes here
o The software accepts inputs only within the
Limits e
range of these limits.

56 Power Monitor Data Menu

NOTE
This screen allows the operator of the software to
operate a transfer switch and possibly start and run a
generator set in aremote location that is not within sight
of the operator. Use extreme care when using this
feature to prevent accidental starting of the generator
set or unexpected transfer or power.

Information Setup Screen Information

Timed Test Displays YES under the Present column
when running a timed test, NO otherwise.

To set the timed test run time and start the timed test,
proceed as follows:

1. Position the cursor in the Run Time row, Setup
column.

2. Type the run time for the timed test in
hours:minutes. Maximum time is 72:00 (72 hours,
0 minutes).

3. After making the desired choices, press <F4>,
confirm with Y and press <ENTER> to start the
test. The time you designate as run time will move
from the Setup column to the Present column.

NOTE: Press <F8> to stop the test before the run time
completes.

Run Time Displays timed test run time. See directions
under Timed Test above to run a timed test.

Manual Test Displays YES if running a manual test, NO
otherwise.

To start a manual test proceed as follows:
1. Position the cursor in the Manual row, Setup
column.
2. TypeY.

3. Press <F4>, confirmwith Y and press <ENTER>to
start the test. The test continues until stopped.

NOTE: Press <F8> to stop the manual test.

Contactor Position Displays the ATS contactor
positon NORMAL, OFF, EMERGENCY, or
UNDEFINED to allow observation of the transfer switch
position during a test.
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Section 6. Communication Connections

To use the Monitor software, you must connectthe PC to
combinations of one or more generator set controllers,
automatic transfer switch (ATS) controllers, or power
monitors compatible with the software. The desired
connection determines the necessary hardware.

Local single connection—up to 50 feet

Local single connection—up to 4000 feet

® |ocal area network

Remote single connection

® Remote area network

6.1 Communication Modules

In all cases, communication with a device (a generator
set controller, ATS controller, or power monitor) requires
a communication module installed within the device.

® RS-232—used for direct connection (50 feet
maximum) and remote connection using modems

® RS-485—used for direct connection (4000 feet
maximum) and local or remote network
connections

The power monitor can also have an internal RS-232 to
RS-485 converter module installed that works with an
installed RS-485 communications module to support
the local single connection to 4000 feet and the local and
remote area networks.

The following chart lists the figures showing
communication module connections:

Communications Internal
Type RS-232 to
RS-485
Device Type RS-232 RS-485  Converter
Generator Set ; :
Controller Figure 6-2 = Figure 6-3 -
ATS Controller Figure 6-4 = Figure 6-5 -
Power Monitor Figure 6-6 | Figure 6-7 | Figure 6-7

Figure 6-1. Communication Module Connections

® ®
i e Ribbon cable included with
Generator Set Controller communication module kit
) (]
. P9
See Figure 6-8 for cable
details.” See Figure 6-10 @
or Figure 6-13 for cable ® ®
connections
\ s s
P10
© -]
=
® @
Front | RS-232 Communications
ront pane ® PA-354197-SD
© ®le
NOTE: Front panel o oL —
is shown swung open 8471

Figure 6-2. RS-232 Communication Module Location and Connection for a Generator Set Controller
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q Generator Set
Contioller

RS-485 Communications
PA-354198-SD

o
3 o
\Zmﬁ) P10
~— =

See Figure 6-11, Figure 6-12,
Figure 6-14 for cable connections

or

8472

Figure 6-3. RS-485 Communication Module Location and Connection for a Generator Set Controller

©) 0 || O I ©
[} o)
ATS
Control Panel
@ Ribbon .cablle included _with @
communication module kit
o] o)
See Figure 6-8 for cable E
details. See Figure 6-16 o o o
or Figure 6-19 for cable
connections ® o ] | \ ©
\ To] = wl‘\hﬂ‘q‘u‘ RS-232 Communications
)

!.‘

=

}h

.

PA-294867-SD,
Option DD-51-B, or
Option KD-51-B

8474

Figure 6-4. RS-232 Communication Module Location and Connection for
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Automatic Transfer Switch (ATS) Controllers
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o p—— — R S—

ATS RS-485 Communications
Control Panel PA-294866-SD,
Option DD-51-A, or
o [@ Option KD-51-A
See Figure 6-17, Figure 6-18, or
Figure 6-20 for cable connections 8475

Figure 6-5. RS-485 Communication Module Location and Connection for
Automatic Transfer Switch (ATS) Controllers

Ribbon cable connects to

P9 of the power monitor Ribbon cable included with

© © o) ~ © communication module kit
|| RCOII;;C_T S N ,__:__‘PQ
6 BOARD @ @ Ll— T
— ol { T R B ¢ RS-232 Communications
12 of I N 2 PA-353395-SD
'l o ©f [ Mounts on back of cover
J o °Ff [ with component side of
J o g @ | I I ¥ module toward inside of
(I o |_|_ _|_| | device when cover is replaced
% ol power monitor ® CJ
o © 3l ol | ls
1 o °Ff I I
| o °Ff o [
. ° O |a | | | | | |
.| o °Ff | |
1 of le el
| o of & = 8|
L3 [ coo0000000000 |
© © : ©
S T 5= -
See Figure 6-8 for cable details.
See Figure 6-22 or Figure 6-25
NOTE: Back of enclosure door shown. for cable connections 8476

Figure 6-6. RS-232 Communication Module Location and Connection for the Power Monitor

MP-5823 3/98 Communication Connections 59




) Ribbon cable included with
Ribbon cable connects to communication module kit

P9 of the power monitor
RS-485 Communications

© _O_ 6 £0 PA-353396-SD
BTESARD =T o o ‘P$ 1 Mounts on back of cover with component side of module
e oh | toward inside of device when cover is replaced
1o I I
oo Iy Mounting location for internal
@:: s ok ° N RS-232 to RS-485 converter
;¢ :f  power monitor |P1 - PA-353397-SD
o of |
° ¢ | /L;‘-j\jl\/}@ °° /
o

See Figure 6-23, Figure 6-24, or
Figure 6-26 for cable connections

e SO XK D[a:ﬂ]

NOTE: Back of enclosure door shown. 8477

Figure 6-7. RS-485 Communication Module Location and Connection for the Power Monitor
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6.2 Communication Hardware

Each connection type and device uses a specific set of
communication hardware.

6.2.1 RS-232 Cable Details

See Figure 6-8 for details on RS-232 cables and
adapters that connect directly from a PC to a device or
from the PC to the modem and from the modem to the
device. The 9-pin female to 25-pin male adapter
converts certain types of PC serial ports that use 9-pin
serial ports to the 25-pin output for use with the cables.

PC to Modem or RS-232 to RS-485 Converter Cable
294981

FEMALE | MALE

Modem to Device or RS-232 to RS-485 Converter Cable
294982

MALE MALE

9-Pin Female 25-Pin Male

NOTE:

All cables are molded-shielded RS-232 DB-25 with thumbscrews.
All pins to be gold plated.

204988 Connector All cables labeled on one end with the part number shown.

All cables to be 10’ in length.

Cable 294981 has the following connections:
Pin 1 to Pin 1.

Pin 2 to Pin 2.

Pin 3 to Pin 3.

Pin 4 to Pin 4.

Pin 5 to Pin 5.

Pin 6 to Pin 6.

Pin 7 to Pin 7.

Pin 8 to Pin 8.

Pin 20 to Pin 20.

Cable 294982 has the following connections:
Pin 1 to Pin 1.

Pin 2 to Pin 3.

Pin 3 to Pin 2.

Pin 4 to Pin 5.

Pin 5 to Pin 4.

Pin 6 to Pin 20.

Pin 7 to Pin 7.

Pin 8 to Pin 20.

Pin 20 to Pins 6 & 8.

8478

Figure 6-8. RS-232 Cable Details
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6.2.2 Generator Set Controller

See

Figure 6-9 for

generator

set controller

communication hardware requirements.

Communication Module Accessory

Additional Hardware
Required

Connection Type Mounted Loose (see references below)
Local up to 50 feet PA-354197-SD,
See Figure 6-10 354197, RS-232 RS-232 1
Local up to 4000 feet PA-354198-SD,
See Figure 6-11 354198, RS-485 RS-485 1,2,and 3
Local area network 354198, RS-485, PA-354198-SD, 1 2 and 3
See Figure 6-12 for each controller RS-485, for each controller $
Remote single connection PA-354197-SD,
See Figure 6-13 354197, RS-232 RS-232 4and5
Remote area network 354198, RS-485, PA-354198-SD,

2,3,4,and 5

See Figure 6-14

for each controller

RS-485, for each controller

2
3
4.
5
N

Additional Hardware:
1. PA-294992-SD, PC to RS-232 cable and connector

PA-352249-SD, External RS-232 to RS-485 converter

. Customer-supplied cable, Belden #9841 or equivalent

PA-294864-SD, Modem for PC end

. PA-294865-SD, Modem for controller end

ote: For sites with multiple devices or networks see respective figures to prevent duplication of hardware.

Figure 6-9. Generator Set Controller Communication Hardware

*

For 9-pin serial port use 9-pin female
to 25-pin male converter connector

294988

M=

Generator Set
Controller

294981 * [

Back of PC

See Figure 6-8 for cable details

10 ft. RS- 232 Cable

ltems included in PA-294992-SD, cable kit for direct PC connection

354197 or
PA-354197-SD

8479

Figure 6-10. Local Single Connection Up to 50 ft. (15.24 m)
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For 9-pin serial port use 9-pin female External RS-232 to Generator Set
to 25-pin male converter connector RS-485 Converter Controller
294988 B-352250

el MF >

10 ft. RS-232 Cable >
Back of PC 204981 * E \ \ L2, .2

354198 or
PA-354198-SD

3
B
191

AC Wall-Mounted
Transformer

(eloleolslele]

QO RECEIVE

O TransmiT Belden #9841

or equivalent ** Resistor

GND o Connect
+ o + to -
712 7

GND O Connect + to +

POWER o -to -

SUPPLY O GND to Shield

AC Wall-Mounted
e Transformer

*  See Figure 6-8 for cable details
**  Maximum cable length of 4000 ft. from RS-485 converter to the last generator set controller
ltems included in PA-294992-SD, cable kit for direct connection to PC

ltems included in PA-352249-SD, external RS-232 to RS-485 converter kit 84710

Figure 6-11. Local Single Connection Up to 4000 ft. (1219.2 m)
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For 9-pin serial port use 9-pin female  External RS-232 to

to 25-pin male converter connector RS-485 Converter Last Generato_r
294988 B-352250 Generator Set Generator Set  Set Controller in
\ Controller #1 Controller #2 Network

s M=

10 ft. RS- 232 Cable
294981 * [1]

Back of PC
AC Wall-Mounted /
Transformer 354198
m ~ PA-354198-SD
+&51 +5
(O RECEIVE
O TRANSMIT

Belden #9841
or equivalent **

GND
+

OO 0O 0O 00

GND Connect + to +

Connect + to +

Q9Q000

POWER -to - —to -
suepLY GND to Shield GND to Shield Resistor 2
Between Devices Connect
& 2 & -
—~ AC Wall-Mounted [ SO o oOINCOO®) +to-on
Transformer N / Last Device
Belden #9841 in Network
or equivalent **
*  See Figure 6-8 for cable details
**  Maximum cable length of 4000 ft. from RS-485 converter to last generator set controller
ltems included in PA-294992-SD, cable kit for direct connection to PC
Items included in PA-352249-SD, external RS-232 to RS-485 converter kit 84711

Figure 6-12. Local Area Network

Telephone
For 9-pin serial port use 9-pin female ) Network ,
to 25-pin male converter connector w‘: :’L‘-'”e
294988 Generator Set
294986 Controller

10 ft. RS-232 Cable
Back of PC 294981 *[1]

Modem
o ]
O Oo 8
o 294987 ** /
/ Modem [2]
©X< é‘ e}

10 ft. RS 232 Cable
294982 *

354197 or
See Figure 6-8 for cable details PA-354197-SD

Modem 294987 is the same as modem 294986, except 294987 is set for AutoAnswer
ltems included in PA-294864-SD, modem kit for PC end
ltems included in PA-294865-SD, modem kit for controller end

*
*%

84712

Figure 6-13. Remote Single Connection
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294986 Telephone 294987
For 9-pin serial port use Modem Network  Modem

9-pin female to 25-pin male
Tel Line Tel Line

converter connector
294988

"Ll T
LQ% ) / \10 ft. RS-232 Cable

10 ft. RS-232 Cable 294982
294981 * =N

Last Generator

Generator Set Generator Set  Set Controller in
Controller #1

Controller #2 Network

Back of PC
External RS-232 to/
RS-485 Converter
B-352250
AC Wall-Mounted 354198
Transformer o > PA-354198-SD
e 51 +5
©
O RECEIVE =
(O TRANSMIT
Belden #9841
ao| O or equivalent ** A
+ O
- O
GND O Connect + to + Connect + to +
POWER N -to - —-to -
SUPPLY | | GND to Shield GND to Shield
Between Devices Resistor
ACWalkMounted oo/ oot iooooy/  fomedt
_~~ Transformer N\ Belden #9841 Last Device
or equivalent ** in Network
*  See Figure 6-8 for cable details
** Maximum cable length is 4000 ft. from RS-485 converter to last generator set controller
ltems included in PA-294864-SD, modem kit for PC end
ltems included in PA-294865-SD, modem kit for controller end
Items included in PA-352249-SD, external RS-232 to RS-485 converter kit 84713

Figure 6-14. Remote Area Network
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6.2.3 ATS Controller

See Figure 6-15 for automatic transfer switch controller
communication hardware requirements.

Communication Module Accessory

Additional Hardware
Required

See Figure 6-20

RS-485, for each controller

RS-485, for each controller

Connection Type Mounted Loose (see references below)
Local up to 50 feet PA-294867-SD,
See Figure 6-16 DD-51-B or KD-51-B, RS-232 RS-232 1
Local up to 4000 feet PA-294866-SD,
See Figure 6-17 DD-51-A or KD-51-A, RS-485 RS-485 1,2,and 3
Local area network DD-51-A or KD-51-A, PA-294866-SD, 1 2 and3
See Figure 6-18 RS-485, for each controller RS-485, for each controller e
Remote single connection PA-294867-SD,
See Figure 6-19 DD-51-B or KD-51-B, RS-232 RS-232 4and5
Remote area network DD-51-A or KD-51-A, PA-294866-SD, 23 4 and5

Additional Hardware:

1. PA-294992-SD, PC to RS-232 cable and connector

2. PA-352249-SD, External RS-232 to RS-485 converter
3. Customer-supplied cable, Belden #9841 or equivalent
4. PA-294864-SD, Modem for PC end

5. PA-294865-SD, Modem for controller end

Note: For sites with multiple devices or networks see respective figures to prevent duplication of hardware.

Figure 6-15. Automatic Transfer Switch (ATS) Controller Communication Hardware
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For 9-pin serial port use 9-pin female
to 25-pin male converter connector
294988

[OX =3
O O
10 ft. RS-232 Cable
294981 *

Back of PC

*  See Figure 6-8 for cable details
ltems included in PA-294992-SD, cable kit for direct PC connection

ATS Controller

PA-294867-SD,
Option DD-51-B, or
Option KD-51-B

84714

Figure 6-16. Local Single Connection Up to 50 ft. (15.24 m)

For 9-pin serial port use 9-pin female External RS-232 to
to 25-pin male converter connector RS-485 Converter
294988 B-352250

el MF >

10 ft. RS-232 Cable

Back of PC 294981 * D:

AC Wall-Mounted
Transformer

QO RECEIVE
O TRANSMIT

GND

+

GND
POWER
SUPPLY

QPLOOO0

*  See Figure 6-8 for cable details

**  Maximum cable length of 4000 ft. from RS-485 converter to the last ATS

ltems included in PA-294992-SD, cable kit for direct connection to PC

ATS Controller

TB1

— + GND — + GND

PA-294866-SD
Option DD-51-A or
Option KD-51-A

Belden #9841
or equivalent **

Connect + to +
— to -
GND to Shield

AC Wall-Mounted

/ Transformer

Items included in PA-352249-SD, external RS-232 to RS-485 converter kit

OO O O OO

Resistor
Connect

ﬂ +to -

84715

Figure 6-17. Local Single Connection Up to 4000 ft. (1219.2 m)
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For 9-pin serial port use 9-pin female External RS-232 to ATS Controller ATS Controller Last ATS Controller
to 25-pin male converter connector RS-485 Converter

294988 B-352250 in Network

s M=

10 ft. RS- 232 Cable

294981 * [1] ,
Back of PC AC Wall-M d/
all-Mounte
Transformer gﬁtﬁ)%4g%65s1DA N

b o Option KD-51-A

TB1

(O RECEIVE
O TRANSMIT

Belden #9841
or equivalent. **

GND
+

[olelololeols]

GND
POWER

Connect + to +

Connect + to +
- to -

Q9Q000

-to -
SUPPLY GND to Shield GND to Shield Resistor
Between Devices Connect
—~ AC Wall-Mounted o=/ St =2/ +to - on
Transformer N / Last Device
Beldep #9841 in Network
or equivalent **
*  See Figure 6-8 for cable details
** Maximum cable length of 4000 ft. from RS-485 converter to last ATS controller
ltems included in PA-294992-SD, cable kit for direct connection to PC
Items included in PA-352249-SD, external RS-232 to RS-485 converter kit 84716

Figure 6-18. Local Area Network

Telephone
For 9-pin serial port use 9-pin female Network

i Tel Line Tel Line
to 25-pin male converter connector
294988 ATS Controller

294986 \
Modem
g L] o ——u
O Oo 8 [ N
o 294987 ** /
/ Modem [2] (
@3% o - .

10 ft. RS-232 Cable
Back of PC 294981 *[1]

10 ft. RS 232 Cable PA-294867-SD,
294982 * Option DD-51-B, or
Option KD-51-B

See Figure 6-8 for cable details

Modem 294987 is the same as modem 294986, except 294987 is set for AutoAnswer
ltems included in PA-294864-SD, modem kit for PC end

ltems included in PA-294865-SD, modem kit for controller end

SI=

84717

Figure 6-19. Remote Single Connection
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294986 Telephone 294987
For 9-pin serial port use Modem Network  Modem
9-pin female to 25-pin male
converter connector
294988

e T

Tel Line\ Tel Line

ATS Controller ATS Controller Last ATS Controller
in Network

/ 10 ft. RS-232 Cable

10 ft. RS-232 Cable 294982
294981 * =
Back of PC
External RS-232 to— -
RS-485 Converter
B-352250
AC Wall-Mounted PA-294866-SD
Transformer Option DD-51-A or
- B Option KD-51-A - j
- i et
O RECEIVE E
O TRaNsuT Belden #9841
aND or equivalent ** I

+

- N

Connect + to + Connect + to +
-to - -to -

GND
POWER

Q9Q000

SUPPLY GND to Shield GND to Shield
Between Devices Resistor
AC Wall-Mounted o) oot iy Somedt
~~~ Transformer N\ Belden #9841 Last Device

or equivalent ** in Network

*  See Figure 6-8 for cable details

**  Maximum cable length is 4000 ft. from RS-485 converter to last ATS

ltems included in PA-294864-SD, modem kit for PC end

ltems included in PA-294865-SD, modem kit for controller end

ltems included in PA-352249-SD, external RS-232 to RS-485 converter kit 84718

Figure 6-20. Remote Area Network
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6.2.4 Power Monitor

See Figure 6-21 for power monitor communication
hardware requirements. Choose between an external
or internal RS-232 to RS-485 converter when a power

monitor is used in an RS-485 network. The figures show

the external

converter, but an

internal converter

installed inside the power monitor connects in the same

manner.

Communication Module Accessory

Additional Hardware
Required

See Figure 6-25

RS-232

Connection Type Mounted Loose (see references below)
Local up to 50 feet PA-353395-SD,
See Figure 6-22 353395, RS-232 RS-232 1
Local up to 4000 feet PA-353396-SD,
See Figure 6-23 353396, RS-485 RS-485 1,20r3,and 4
Local area network 353396, RS-485, PA-353396-SD, 1 20r3. and 4
See Figure 6-24 for each power monitor | RS-485, for each power monitor ’ ’
Remote single connection 353395, RS-232 PA-353395-SD, 5and 6

Remote area network
See Figure 6-26

353396, RS-485,
for each power monitor

PA-353396-SD,
RS-485, for each power monitor

20r3,4,5 and 6

Additional Hardware:

1. PA-294992-SD, PC to RS-232 cable and connector
2. PA-352249-SD, External RS-232 to RS-485 converter
3. PA-353397-SD, Internal RS-232 to RS-485 converter

4. Customer-supplied cable, Belden #9841 or equivalent
5. PA-294864-SD, Modem for PC end

6. PA-294865-SD, Modem for power monitor end
Note: For sites with multiple devices or networks see respective figures to prevent duplication of hardware.
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Figure 6-21. Power Monitor Communication Hardware
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Power Monitor

\k‘» S, [-) 20

sssss

]
g
°|.|£
—3 8

©000000000000000

-1
]
]
— —
— ——U

*
2
i

/”/’ - -
—

©0000000000000000

e

For 9-pin serial port use 9-pin female o ocoeeeeenie g

to 25-pin male converter connector K-) u—-“Jj

294988
O Oo 8
: 10 ft. RS-232 cable 353395 or
294981 * PA-353395-SD
O

Back of
PC
* See Figure 6-8 for cable details
ltems included in PA-294992-SD, cable kit for direct PC connection 84719

Figure 6-22. Local Single Connection Up to 50 ft. (15.24 m)

For 9-pin serial port use 9-pin female  External RS-232 to Power
to 25-pin male converter connector RS-485 Converter Monitor 353396 or
294988 B-352250 \ L A 555396-5D
“Le TR : |
10 ft. RS-232 Cable
Back of PC 294981 * S Location for Internal
4 1+61+5 RS-232 to RS-485
v Converter
AC Wall-Mounted 353397 or
Transformer PA-353397-SD

O REecevE
O TRANSMIT

Belden #9841
or equivalent **

Resistor

GND O Connect
+ 4 -
119 JJ +to
GND O Connect + to +
POWER O -to -
SUPPLY 1 GND to Shield

AC Wall-Mounted
/ Transformer

*  See Figure 6-8 for cable details

**  Maximum cable length of 4000 ft. from RS-485 converter to power monitor

ltems included in PA-294992-SD, cable kit for direct connection to PC

Items included in PA-352249-SD, external RS-232 to RS-485 converter kit 84720

Figure 6-23. Local Single Connection Up to 4000 ft. (1219.2 m)
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Power Power Last Power

For 9-pin serial port use 9-pin female  External RS-232 to Monitor #1 Monitor #2 Monitor
to 25-pin male converter connector RS-485 Converter \
294988 B-352250

10 ft. RS- 232 Cable
294981 * [1]

PN N =

353396 or

Back of PC / PA-353396-SD
AC Wall-Mounted
Transformer
4 | +% | +%
©
(O RECEIVE =
O Thansur Belden #9841
aw| O or equivalent ** I
+ O
- O. \
GND O Connect + to + Connect + to +
POWER N -to - —to -
SUPPLY O GND to Shield GND to Shield
Between Devices |0 ggﬁ'ﬁ;ﬂ @
\ J \ J
AC Wall-Mounted \OOO_/ KOOOO OOOO/ +to-on
_~~ Transformer N\ Belden #9841 Last Device
or equivalent ** in Network
*  See Figure 6-8 for cable details
** Maximum cable length of 4000 ft. from RS-485 converter to last power monitor
ltems included in PA-294992-SD, cable kit for direct connection to PC
Items included in PA-352249-SD, external RS-232 to RS-485 converter kit 84721
Figure 6-24. Local Area Network
Telephone .
For 9-pin serial port use 9-pin female Tel Li Network . Power Monitor
to 25-pin male converter connector 4|el ine |7T6| Line
294988
294986

Modem
o ]
O Oo 8
o 294987 ** /
/ Modem [2]
©X< é‘ e}

10 ft. RS-232 Cable
Back of PC 294981 *[1]

10 ft. RS 232 Cable 353395 or
294982 * PA-353395-SD

*

See Figure 6-8 for cable details

** Modem 294987 is the same as modem 294986, except 294987 is set for AutoAnswer
ltems included in PA-294864-SD, modem kit for PC end

ltems included in PA-294865-SD, modem kit for controller end

84722

Figure 6-25. Remote Single Connection
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For 9-pin serial port use

9-pin female to 25-pin male
converter connector
294988

e T

294986
Modem Network

/

Telephone

Tel Line\ Tel Line

10 ft. RS-232 Cable

294981 *

Back of PC

O RECEIVE
(O TRANSMIT

GND

+

GND
POWER
SUPPLY

External RS-232to— .
RS-485 Converter

B-352250

Q9Q000

Bel

10 ft. RS-232 Cable
294982

S

AC Wall-Mounted
Transformer

den #9841

or equivalent **

=

Connect + to +

-to -

294987
Modem

Power

Monitor #1

\

Power
Monitor #2

Last Power
Monitor

191

353396 or
PA-353396-SD

GND to Shield

AC Wall-Mounted
/ Transformer

*  See Figure 6-8 for cable details

** Maximum cable length is 4000 ft. from RS-485 converter to last power monitor
ltems included in PA-294864-SD, modem kit for PC end

ltems included in PA-294865-SD, modem kit for controller end

Items included in PA-352249-SD, external RS-232 to RS-485 converter kit

[ONONONONON®)

Connect + to +
- to —

GND to Shield
Between Devices

"\ Belden #9841
or equivalent **

Ol x-6058-27
JJ Resistor

(120-Ohms)
Connect
+to - on
Last Device
in Network

84723
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6.2.5 Different Devices On The Same
Remote Area Network

A local area network or a remote area network can also
be configured using any combination of power monitors,
generator controllers, and automatic transfer switch
(ATS) controllers.

Figure 6-27 shows an example of a network with one of
each of the devices illustrated. Insert another device at

any point in the network. You must connect the
termination resistor across the last device on the
network on the unused RS-485 communications port.
Note that an internal RS-232 to RS-485 converter (part
number 353397 or PA-353397-SD) mounted in the
power monitor can substitute for the external model
(part number PA-352249) shown; the connections are
the same.

“Le T

10 ft. RS-232 Cable

294986 Telephone 294987
For 9-pin serial port use Modem Network ~ Modem
9-pin female to 25-pin male . )
converter connector Tel Line\ Tel Line \ . Device #2, Last Device
294988 Device #1, Generator Set  in Network,
Power Monitor ~ Controller ATS Controller

™10 ft. RS-232 Cable

d
(EXEITRERTXTTMN |
T T

RS-485 Communications
Module Required for Each
Device

— + GND — + GND

PE=NE

294982
294981 * =
Back of PC
External RS-232 to —
RS-485 Converter
B-352250
AC Wall-Mounted
Transformer
QO RECEIVE
(O TRANSMIT

Belden #9841
or equivalent **

GND
+

Connect + to +
- to -
GND to Shield

GND
POWER
SUPPLY

Q9Q000

AC Wall-Mounted
/ Transformer

*  See Figure 6-8 for cable details

ltems included in PA-294864-SD, modem kit for PC end
ltems included in PA-294865-SD, modem kit for controller end

** Maximum cable length is 4000 ft. from RS-485 converter to last device

OO0 O O 00

Connect + to +
- to -

GND to Shield
Between Devices

& — OOOOJ Resistor [3]
N\ Belden #9841 gfﬁﬁggm)

H *%
or equivalent +10 — on Last

Device in Net-
work

Items included in PA-352249-SD, external RS-232 to RS-485 converter kit

84724

Figure 6-27. Remote Area Network Consisting of one or more
Power Monitors, Generator Controllers, and Transfer Switch Controllers.
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Section 7. Factory Setup Option

7.1 Enabling the Factory Setup
Option

Use the Monitor software from the command line as
follows to enable the factory setup option:

Spectrum.exe -f

If running the software from DOS, type in the command
line as shown. If using Windows®, run the command line
shown from File->Run in Windows® 3.1 or Start->Run
in Windows® 95.

To change the normal installation to enable the factory
setup option, follow the procedures below to edit the
Program Group or shortcut.

Editing your Program Group in Windows® 3.1:

1. Double click on the program group for the monitor
software.

2. Select the icon for the monitor software.

3. Choose File->Properties and add the -f option to
the end of the text in the Command Line: box and
click OK.

Editing your shortcut in Windows® 95:

1. Find the shortcut you normally use to run the
software. If you normally run the program from the
Start menu, choose Start-> Settings—> Taskbar->
Start Menu Programs-> Advanced and browse for
the shortcut.

2. Right click on the shortcut and choose Properties.
In Properties choose the Shortcut or Program tab.
Add the —f option to the end of the command line in
the Target: or Cmd line: box and click Apply.

The following sections detail what information can be
modified when using -f factory setup option. Each ofthe
following sections is for a particular device.

7.2 Generator Set Controller

The following information can also be changed in the
Setup column on the Information Setup Screen for a
generator set controller using the factory setup option.
See Figure 3-9. Use the up and down arrow keys to
navigate through the list. Use the <F4> key to update
the information when changes are complete.

System Voltage The generator set voltage. Enter the
system voltage shown on the generator set nameplate.

System Frequency The generator set frequency. Enter
the system frequency shown on the generator set
nameplate.

Single/Three Phase The generator set electrical system
type: SINGLE for single-phase, 3 WYE for three-phase
wye, or 3 DELTA for three-phase delta. Use the + and -
keys to select the electrical system type shown on the
generator set nameplate.

KW Rating The generator set kilowatt rating. Enter the
kilowatt rating shown on the generator set nameplate.
Battery Voltage The battery voltage for the generator set.
Enter the battery voltage shown on the generator set
nameplate.

Model No. The generator set model number. Enter the
model number shown on the generator set nameplate up
to 26 characters.

Spec No. The generator set specification number. Enter
the specification number shown on the generator set
nameplate up to 16 characters.

Serial No. The generator set serial number. Enter the
serial number shown on the generator set nameplate up to
6 digits.

Control Serial Number The generator set controller
serial number. Type in the generator set controller serial
number up to 6 digits.

7.3 ATS Controller

The following information can also be changed in the
Setup column on the Information Setup Screen for both
the Normal and Emergency sources for an ATS
controller using the factory setup option. See
Figure 4-13. Use the up and down arrow keys to
navigate through the list. Use the left and right arrows to
select the Normal or the Emergency source column.
Use the <F4> key to update the information when
changes are complete.

System Voltage The system voltage. Enter the system
voltage for the Normal or Emergency source.

System Frequency The system frequency. Enter the
system frequency for the Normal or Emergency source.

Single/Three Phase Electrical system type: 1 for
single-phase, 3 for three-phase. Enter 1 or 3 to select the
electrical system type for the Normal or Emergency
source.

Microsoft MS and MS-DOS are registered trademarks and Windows is a trademark of Microsoft Corporation in the Unitied States and other countries.
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7.4 Power Monitor

The following information can also be changed in the
Setup column on the Information Setup Screen for a
power monitor using the factory setup option. See
Figure 5-8. Use the up and down arrow keys to navigate
through the list. Use the <F4> key to update the
information when changes are complete.

System Voltage The monitored system voltage. Enter
the system voltage for the monitored system.

System Frequency The monitored system frequency.
Enter the system frequency for the monitored system.

Single/Three Phase Electrical system type: SINGLE for
single-phase, 3 WYE for three-phase wye, or 3 DELTA for

76 Communication Connections

three-phase delta. Use the + and - keys to select the
electrical system type for the monitored system.

ATS Rating The ATS contactor current rating. Enter the
contactor current rating shown on the ATS nameplate.

Model No. The ATS model number. Enter the model
number shown on the ATS nameplate up to 26 characters.

Spec No. The ATS specification number. Enter the
specification number shown on the ATS nameplate up to
16 characters.

Serial No. The serial number for the ATS. Enter the serial
number shown on the ATS nameplate up to 6 digits.

Control Serial Number The ATS controller serial number.
Enter the ATS controller serial number up to 6 digits.
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Appendix A. Glossary of Abbreviations

Abbreviations are used throughout this manual. Normally in the text they will appear in complete form with the
abbreviation following in parenthesis the first time they are used. After that they will appear in the abbreviated form.
The commonly used abbreviations are shown below.

AC
AISI
Amp
Amps
ANSI

API

approx.

AR
A/S

ASA
ASME

assy.
ASTM

ATDC
aux.
AWG
AWM
BBDC
BDC
BHP
bmep
Btu
°C

cc
CCA
CEC
cfh
cfm
CID
cm
cmm
co.
cont’d.
CSA
CT
cu. in.
cyl.
dB
dBA
DC
DCR
deg.
dept.
dia.
e.g.
EIA
EMI
EPA

etc.
ext.
°F

fl. oz.
FM

ft.

ft. lbs.

ga.

alternating current

American Iron and Steel Institute
ampere

amperes

American National Standard
Institute

American Petroleum Institute
approximate, approximately
as required, as requested

as supplied, as stated,

as suggested

American Standards Association
American Society of Mechanical
Engineers

assembly

American Society for Testing
Materials

after top dead center
auxiliary

American Wire Gauge
appliance wiring material
before bottom dead center
before dead center

brake horsepower

brake mean effective pressure
British thermal unit

Celsius degree

cubic centimeter

cold cranking Amps.
Canadian Electrical Code
cubic feet per hour

cubic feet per minute

cubic inch displacement
centimeter, centimeters
cubic meters per minute
company

continued

Canadian Standards Association
current transformer

cubic inch, cubic inches
cylinder

decibel

decibels (A weighted)

direct current

direct current resistance
degree

department

diameter

example given

Electronic Industries Association
electromagnetic interference
Environmental Protection
Agency

et cetera (and so forth)
external

Fahrenheit degree

fluid ounce, fluid ounces
frequency modulation

foot, feet

foot pound, foot pounds
gauge
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gal./ gals. gallon, gallons

gph
gpm
gr.
grd.
HCHT
HET

Hg
HoO
HP

hr, hrs
Hz

ID
IEEE

in.

inc.

in. Ibs.
int.
int.-ext.
1ISO

J

JIS

kg
kg/cm?
kgm

kJ

km
kPa
kph

kV
kVA
kW
kWH

L
LxWxH
LED(s)
Ib., Ibs.
L/hr.
L/min.
LOP
LP

m

m3
max.
MCM
megger
MHz
mi.

mil
min.
mJ

MJ
mm
m3/min
MPa
mwW
MW
N/A

gallons per hour

gallons per minute

grade

ground

high cylinder head temperature
high exhaust (or engine)
temperature

mercury (element)

water

horsepower

hour

hertz (cycles per second)
inside diameter

Institute of Electrical and
Electronic Engineers
inch(es)

incorporated

inch pounds

internal

internal-external
International Standards
Organization

joule, joules

Japanese Industry Standard
kilogram, kilograms
kilograms per square centimeter
kilogram meter(s)

kilojoules (btu cal)
kilometer, kilometers
kiloPascal, kiloPascals
kilometers per hour

kilovolt

kilovolt amperes

kilowatt, kilowatts

kilowatt hour

liter, liters

length x width x height

light emitting diode

pound, pounds

liter per hour, liters per hour
liter(s) per minutes

low oil pressure

liquefied petroleum

meter, meters

cubic meter, cubic meters
maximum

one thousand circular mils.
megohmmeter

megahertz

mile, miles

one one-thousandth of an inch
minimum

millijoule, millijoules

mega joule, mega joules
millimeter, millimeters
cubic meters per minute
megaPascal

milliwatt, milliwatts
megawatt, megawatts

not available or not applicable

NBS National Bureau of Standards
N.C. normally closed
NEC National Electrical Code

NEMA  National Electrical
Manufacturers Association

NFPA National Fire Protection
Association

Nm Newton meter, Newton meters

no., nos number, numbers
NPT National Standard taper pipe
thread per general use

N/R not required

ocC overcrank

oD outside diameter

OEM original equipment manufacturer

oS overspeed, oversize

0o/S oversize

OSHA  Occupational Safety and Health
Act

ov overvoltage

oz. ounce, ounces

PF power factor

PMG permanent magnet generator

pot. potentiometer

ppm parts per million

psi pounds per square inch

pt., pts. pint, pints

PVC polyvinyl chloride

qt., qts. quart, quarts

qty. quantity

ref. reference

RFI radio frequency interference
r.h.m. round-head machine (screw)
rms root mean square

RPM revolutions per inch

RTV room temperature vulcanization
SAE Society of Automotive Engineers
SCR silicon-controlled rectifier

sec. second, seconds

spec. specs, specification

sq. square

sg. cm  square centimeters

sq. in. square inch, square inches

tach tachometer
TDC top dead center
tech. pub.technical publications

temp. temperature

TIF telephone influence factor
TP, TPs technical publications
turbo turbocharger

UHF ultrahigh frequency
UNC Unified coarse thread (was NC)
UNF Unified fine thread (was NF)

UL Underwriter’s Laboratories, Inc.
u/s undersize

U.S.A.  United States of America

\% volt, volts

vac volts alternating current

vdc volts direct current

VHF very high frequency

W watt, watts
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